Reference Guide

This reference guide is your resource to everything Apex Sketch v6 has to offer, including exercises that will have you drawing simple to complex drawings in a matter of minutes.

With each successive upgrade to the software, we make every effort to keep the drawing techniques and methods consistent from one version to the next. For existing users, many portions of what you’ll read in this guide will be very familiar. If you’re new to Apex, we recommend that you spend some time going through the exercises as they will be your fastest, hands-on way to drawing sketches.
Apex Sketch™ - Copyright© 1987-2015 - Starcap Marketing LLC, dba Apex Software. All Rights Reserved. No part of this manual may be reproduced, reduced, translated or transmitted in any form or by any means, electronic or mechanical, including but not limited to photo-copying, recording or transferring by any information retrieval system without the prior written permission of Apex Software.

Application Concept and Design: Randall H. Garrett, Robert K. Smoote
Engineering/Programming: Andrew Prochaska, John H. Clements
Product Management: Robert K. Smoote
Project Management: Iain G. Nicholson
Testing, QA: Jonathan D. Colon, Iain G. Nicholson, Brian V. Marino, Steven L. Kemp
Apex Art/Manual Design/Implementation: Robert K. Smoote

Apex Software makes no warranties; either expressed or implied, as to the complete accuracy of this manual, and reserves the right to revise same and to make changes to the contents hereof at any time without notice.

Apex License Agreement
Apex Software hereby grants the purchaser of this software a personal, non-transferable and non-exclusive right and license to use the program under the terms stated in this agreement. Title, ownership and/or rights in and to the program and the related documentation remain with Apex Software. Installation and use of this program is limited to the original purchaser in accordance with the terms of sale. You and your employees and agents are required to protect the confidentiality of the program. You may not transfer, distribute or otherwise make the program or documentation available to any third party, by any time-sharing or otherwise, without the prior written consent of Apex Software. You may not alter or modify the program. You may not copy or reproduce the program or documentation for any purpose except with the written permission of Apex Software. You acknowledge that you are receiving only a LIMITED LICENSE TO USE the program and related documentation and that Apex Software retains all rights to the program and documentation. This license remains effective until terminated. You may terminate this license at any time by returning to Apex Software, at your expense, the program and related documentation together with all copies and merged portions in any form. This license will also terminate immediately upon conditions set forth elsewhere in the Agreement or if you fail to comply with any term or condition contained herein.

Limited Warranty
Apex Software makes no representation or warranties, either expressed or implied, by or with respect to the program and related documentation, including but not limited to, implied warranties of merchantability or fitness for any particular purpose(s). In no event will Apex Software be liable for any damages, whether direct or indirect, special, consequential or incidental, arising from the use of this program.

Trademarks
Throughout this manual, reference is made to a number of trademarks: Microsoft Windows, Windows 98, Windows 2000, Windows XP, Windows Vista, Windows 7, Windows RT and Windows 8 are registered trademarks of Microsoft Corp.; HP is a registered trademark of Hewlett Packard. Apex, Apex II, Apex IV, Apex Medina, MobileSketch and Nexus are trademarks of Randall H. Garrett, dba Apex Software. All other brand names are trademarks or registered trademarks of their respective companies/owners.
# Table of Contents

Welcome to Apex Sketch v6

Apex License Agreement ............................................................................................................. 1
Limited Warranty .......................................................................................................................... 1
Trademarks .................................................................................................................................... 1

Chapter 1 - Getting Started & Installation .................................................................................. 8

Reference Terminology/Usage ....................................................................................................... 9
  Keyboard & Mouse ....................................................................................................................... 9
  Active Pen & Touch ................................................................................................................... 9
System Requirements ..................................................................................................................... 10
  Active Pen (Required for Inking) ............................................................................................... 10
  Mouse Scroll Wheel (Required for Extended Drawing Functionality) ....................................... 10
Technical Support ......................................................................................................................... 10
Installing Apex Sketch v6 ............................................................................................................. 11
Registration Process ..................................................................................................................... 14
  Online Registration .................................................................................................................. 14
  Manual Registration ................................................................................................................ 16

Chapter 2 - Apex Sketch v6 User Interface ................................................................................. 18

Apex Sketch User Interface ......................................................................................................... 19
The Ribbon Bar .............................................................................................................................. 20
  File Menu ................................................................................................................................ 20
  Home Menu .............................................................................................................................. 21
  View Menu ............................................................................................................................... 23
  Tools Menu ............................................................................................................................... 24
  Help Menu ............................................................................................................................... 24
Quick Access Toolbar .................................................................................................................... 25
  QAT Defaults ........................................................................................................................... 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing the QAT</td>
<td>25</td>
</tr>
<tr>
<td>Customizing the QAT</td>
<td>26</td>
</tr>
<tr>
<td>Title Bar</td>
<td>27</td>
</tr>
<tr>
<td>Program Edition</td>
<td>27</td>
</tr>
<tr>
<td>Directory Path and File Name</td>
<td>27</td>
</tr>
<tr>
<td>Window Controls</td>
<td>28</td>
</tr>
<tr>
<td>Panel System</td>
<td>28</td>
</tr>
<tr>
<td>Accessing the Panels</td>
<td>29</td>
</tr>
<tr>
<td>Locking/Tacking Panels Open</td>
<td>29</td>
</tr>
<tr>
<td>The Area Definition Panel</td>
<td>30</td>
</tr>
<tr>
<td>Text Label Panel</td>
<td>31</td>
</tr>
<tr>
<td>Symbol Library Panel</td>
<td>32</td>
</tr>
<tr>
<td>Area Calculations Panel</td>
<td>33</td>
</tr>
<tr>
<td>Touch Panel</td>
<td>34</td>
</tr>
<tr>
<td>Bluetooth Connection and Ink Disabled Indicators</td>
<td>35</td>
</tr>
<tr>
<td>Sketch Page Indicator</td>
<td>35</td>
</tr>
<tr>
<td>Adding &amp; Inserting Pages</td>
<td>35</td>
</tr>
<tr>
<td>Mode/Heads Up Display (HUD)</td>
<td>36</td>
</tr>
<tr>
<td>Zoom &amp; Scale Controls</td>
<td>37</td>
</tr>
<tr>
<td>Zoom Slider</td>
<td>37</td>
</tr>
<tr>
<td>Scale Control</td>
<td>38</td>
</tr>
<tr>
<td>Canvas/View Tools</td>
<td>38</td>
</tr>
<tr>
<td>Library Tools</td>
<td>39</td>
</tr>
<tr>
<td>Drawing Tools</td>
<td>39</td>
</tr>
<tr>
<td>Selection &amp; Pan Tools</td>
<td>40</td>
</tr>
<tr>
<td>Drawing Port</td>
<td>40</td>
</tr>
<tr>
<td>Options &amp; Settings</td>
<td>41</td>
</tr>
<tr>
<td>Common Settings Dialog Properties</td>
<td>41</td>
</tr>
<tr>
<td>General Settings</td>
<td>42</td>
</tr>
<tr>
<td>Display Settings</td>
<td>43</td>
</tr>
<tr>
<td>Hardware Settings</td>
<td>43</td>
</tr>
</tbody>
</table>
# Chapter 3 - Apex Sketch v6 Drawing Methods

**Apex Sketch v6 Drawing Methods** ................................................................. 47

**Keyboard & Mouse Drawing Method** ......................................................... 48

- Define Area Process .................................................................................. 48
- Drawing Modes ......................................................................................... 48
- Cursor States ............................................................................................ 48
- Drawing with Mouse & Keyboard ............................................................. 49
- Mouse Drawing ......................................................................................... 49
- Drawing with Arrow Keys ....................................................................... 49
- Drawing with Distance & Direction with Keyboard ............................... 49
- Drawing Techniques (Keyboard Only) ....................................................... 49
- Engineering Input .................................................................................... 49
- Architectural Input .................................................................................. 50
- Drawing Your First Shape ....................................................................... 51
- Auto-Pan .................................................................................................. 54
- Center Sketch and Center & Fit ................................................................. 54
- Helpful Hint ............................................................................................. 55
- Pink is Good ............................................................................................ 55
- Drawing a Bay Window – Introduction to Rise & Run ............................ 56
- Stacking Dimensions .............................................................................. 56
- Direct Angle Input – “Turn” .................................................................... 58
- How do I determine the angle of the wall without Rise & Run? ........... 59
- Alignment ............................................................................................... 60
- Alignment Styles .................................................................................... 60
- Importance of Using Alignment Tools .................................................... 61
- Completing Areas with Auto-Close ........................................................ 62
- Saving your Sketches .............................................................................. 62

**System Settings** ...................................................................................... 44

**Font Settings** ......................................................................................... 44

**Drawing Settings** ................................................................................... 45
Export your Sketches ................................................................. 62
Drawing Attached Areas .......................................................... 63
Drawing Curves ........................................................................ 64
Degree of Curvature (Arc Angle) ................................................ 65
Chord Length ........................................................................... 65
Arc Length ............................................................................... 65
Arc Height ............................................................................... 65
Degree of Curvature or Arc Height ............................................ 65
Curve Modifiers (Shift & Ctrl) ................................................... 66
Keyboard & Mouse Drawing Method (continued) ......................... 67
Keyboard & Mouse Drawing Method (continued) ......................... 68

**Active Pen Drawing Method** .................................................. 69

Active vs. Passive Pen ............................................................... 69
Ink vs. Touch ............................................................................. 69
Drawing Modes ......................................................................... 69
Area Definition .......................................................................... 69
Choosing a Starting Point .......................................................... 70
Drawing a Line with Ink ............................................................ 70
Common Misperception 1 – Counting Squares ............................... 70
Pen Away Events ........................................................................ 71
Rendered Line and Dimension ..................................................... 71
Inking yet no Lines .................................................................... 72
Changing a Dimension – Hit Boundary ....................................... 73
Dimension Text Input Panel (DTIP) ............................................. 73
Input Panel vs. Pen Away ............................................................. 74
Practice Makes Perfect ............................................................... 74
Common Misconception 2 – Writing Small ................................. 74
Draw the First Line .................................................................... 75
The Big Red Dot ....................................................................... 76
Other Indicators for Connected Lines ......................................... 76
Common Misconception 3 – Edit Dimension Orientation ............... 77
Centering your Sketch ........................................................................................................................................... 79
Angled Lines with the Active Pen .......................................................................................................................... 82
Alignment Points “Dots” ....................................................................................................................................... 84
Direct Angle Input ................................................................................................................................................ 87
Importance of Using Alignment Points ................................................................................................................ 90
Drawing Attached (multiple) Areas .................................................................................................................... 90
Auto-Jump “Snap” ................................................................................................................................................ 91
Drawing Curves with an Active Pen ................................................................................................................... 92
Where’s Auto-Trace? ........................................................................................................................................... 94

**Touch Drawing Method** ..................................................................................................................................... 97
Accessing the Touch Panel ..................................................................................................................................... 97
Define Area Process ............................................................................................................................................ 98
Drawing Modes .................................................................................................................................................... 98
Cursor States ....................................................................................................................................................... 98
Drawing with Touch ............................................................................................................................................. 99
Finger Drawing ................................................................................................................................................... 99
Drawing with Directional Pad ............................................................................................................................ 99
Drawing with Distance & Direction with Touch Panel ....................................................................................... 99
Drawing Your First Shape .................................................................................................................................. 99
Auto-Pan ............................................................................................................................................................... 103
Center Sketch and Center & Fit .......................................................................................................................... 103
Helpful Hint .......................................................................................................................................................... 104
Pink is Good........................................................................................................................................................ 104
Drawing a Bay Window – Introduction to Rise & Run......................................................................................... 104
Stacking Dimensions ......................................................................................................................................... 105
Direct Angle Input – “Turn” ................................................................................................................................ 106
How do I determine the angle of the wall without Rise & Run? ...................................................................... 108
Alignment ............................................................................................................................................................ 108
Alignment Styles ............................................................................................................................................... 109
Importance of Using Alignment Tools ............................................................................................................ 110
Completing Areas with Auto-Close ................................................................................................................ 110
Drawing Attached Areas ........................................................................................................ 111
Drawing Curves .................................................................................................................. 112
Degree of Curvature (Arc Angle) ...................................................................................... 113
Chord Length ..................................................................................................................... 113
Arc Length ........................................................................................................................ 113
Arc Height ........................................................................................................................ 113
Methods for Drawing Curves ............................................................................................ 113
Curve Modifiers (Shift & Ctrl) ......................................................................................... 114

DISTO Drawing .................................................................................................................. 117
Paired your DISTO ............................................................................................................. 117
Your DISTO Model ............................................................................................................. 119
DISTO D810 Device Setup .............................................................................................. 119
Configuring Apex Sketch v6 for DISTO use .................................................................... 120
Edit in Place ....................................................................................................................... 120
Interactive ........................................................................................................................... 120

Chapter 4 – Area Definition ............................................................................................... 122
Area Definition .................................................................................................................. 123
What happens if the lines in Areas don’t connect? ......................................................... 123

Drag & Drop Area Definition .......................................................................................... 124
Multi-Level Area Definition using Drag & Drop ............................................................. 127

Additive Area Definition ................................................................................................. 129
Modifying/Customizing Area Definitions ....................................................................... 134
Modifying/Customizing Area Definitions (Area Definitions Panel Continued) ............... 135
Applying Factors .............................................................................................................. 135
Area Calculations ............................................................................................................. 135

Shortcut Keys & Ink Gestures .......................................................................................... 136
Keyboard Shortcuts ............................................................................................................ 137
Additional Short-Cut Key Functionality ........................................................................... 137
Modifier Keys .................................................................................................................... 137
Additional Ink Gestures ................................................................................................... 138
Chapter 1

Getting Started & Installation
Reference Terminology/Usage

The conventions used in this manual are relatively straightforward. The manual is laid out in a progressive format where basic techniques are built upon in subsequent sections and/or chapters.

Note: This indicates a note. Notes are intended to provide additional suggestions about a topic or procedure and also serve to alert you to precautionary information.

The following conventions are also used in this reference guide:

- All button names, controls, and other application-specific items are presented in bold type.

- All keyboard-specific input will be displayed in KEYCAP font. For example: [CTRL], [ALT], etc.

- Keys are sometimes used together. If the manual directs you to press ALT along with the C key, this is depicted as [ALT][C]. Thus, [CTRL][SHIFT][R] means to hold down [CTRL] and [SHIFT] keys together and then press [R]. This is what we refer to as Short-Cut keys.

Note: Throughout this manual, we describe how to access functions, features and menu items with a mouse, keyboard, active pen and finger where appropriate for more efficient use of the program.

Keyboard & Mouse

Mouse actions refer to a left-click unless otherwise noted. For example, “Click Ok” implies “Using the left mouse button, click the Ok button on the given dialog.”

Direction Keys is a collective name for the up arrow, down arrow, left arrow, and right arrow. Throughout this manual these keys are illustrated as, [↑], [↓], [←], and [→] respectively.

Navigation to menu items and an associated function is depicted in bold-faced SMALL CAPS, with a “greater than” symbol (>) to indicate a hierarchal structure. For example, navigating to the Save function within the File menu is depicted as File>Save.

Active Pen & Touch

“Click” functions with Pen or Finger are replaced with “Tap”. For example, “Tap Ok” implies “Using your pen or finger to tap the Ok button on the given dialog.”

“Pinch” or “Expand” implies a two finger pinching or spreading gesture on the surface of your mobile device to perform the described function.
System Requirements
Generally speaking, any Desktop, Windows Tablet or Tablet PC capable of running Microsoft® Windows™ 7 or higher as the primary operating system can effectively run Apex Sketch. We highly recommend a screen resolution of 1366x768 or higher for optimized performance.

Note: Apex Sketch v6 does not support Windows XP or lower. Microsoft® Windows™ 7 or higher is required to launch Apex Sketch v6. For the optimum performance, we highly recommend Windows™ 8 or 8.1.

Active Pen (Required for Inking)
Apex Sketch v6 is designed to support multiple forms of input. However, if you wish to take advantage of the inking and hover functionality, your device must support active digitizers (aka Active Pen). Please check with your mobile device manufacturer for more information regarding its support of the Active Pen.

Mouse Scroll Wheel (Required for Extended Drawing Functionality)
Although it is not required, Apex Sketch v6 is designed to take full advantage of the scroll wheel on your mouse for certain functions available when equipped.

Note: Apex Sketch does not require Active Pen or a Mouse Scroll Wheel to effectively draw sketches. These are only required if you wish to take advantage of the additional functionality built-in to the program designed specifically for these peripherals.

Technical Support
In the event you encounter difficulty with your program or installation, we’re only a phone call away. You can reach our Technical Support staff for assistance:

Phone: 800.858.9958
FAX: Monday – Friday, 8:30am – 5:30pm CST
Business Hours: 210.699.1150
Email: tech@apexwin.com
Installing Apex Sketch v6

Whether you’ve downloaded Apex Sketch v6 from our website (www.apexwin.com) or received the application on CD, the installation is essentially the same. The following will take you through a series of steps to ensure Apex Sketch v6 has been properly installed to your computer or mobile device.

To launch the installation program, locate it in the directory it was downloaded to or access it from the CD you received from Apex Software.

Once you have launched the installation program, dialogs will appear to help guide you through the process of installing Apex Sketch v6 to your computer.

The first dialog displayed during the installation process welcomes you to Apex Sketch v6 and prompts you to click (or tap) Next to continue.

**Note:** At any point during the installation process you may click Back to return to the previous dialog or Cancel to abort the installation process.

The following dialog presents you with the Apex EULA (End-User License Agreement) which details various guidelines, restrictions and policies that you must accept in order to continue with the installation process. Upon accepting the terms, the Next button will activate.
Once you've selected the type of installation, the following dialog will provide you with additional installation options pertaining to the Shortcuts you will use to access the application. If you do not wish to create the shortcuts to your desktop or taskbar, uncheck the options you wish to remove. Click (or Tap) **Next** to continue.

Once you see the dialog illustrated to the right, you have completed everything necessary to begin the installation of Apex Sketch v6. This dialog gives you one last opportunity to change any selections before installing the program files to your computer or mobile device. If you’re satisfied with your selections, Click (or Tap) **Install** to continue.

After launching the install process from the previous dialog, the installer will display a status bar marking the progress during the installation.
When the installation has finished copying the necessary components to your computer, you will be notified and given the option to complete the installation. Clicking Finish allows the installer to finalize the installation and perform the clean-up of temporary files or processes still in memory.

**Important Note:** Before running Apex Sketch v6 in an integrated fashion, you must first launch the program as stand-alone to register your software.

Congratulations! You've Successfully Installed Apex Sketch v6!
Apex Sketch v6 is ready to be launched for the first time which will lead you through the registration process.
Registration Process
Apex Sketch v6 offers both online and manual activation of your licenses for each computer and/or mobile device you wish to use it on. Chances are, you’ve already purchased Apex and already have an online account with licenses ready for activation. If not, contact Apex at 800-858-9958 for further assistance with licensing your product.

When you launch Apex Sketch v6 for the first time, you will see the following dialog:

This dialog is informing you that the version of Apex you are attempting to run is not registered and offering two different options from which you may register your program – Online Registration or Manual Registration.

Online Registration
This is the fastest and easiest way to register your Apex product. Online registration is available 24/7 which means you can register your product whenever you’re ready to with no fear of any down-time because our offices are closed.

Do I Choose Standard or Pro?
At the time of purchase, you should have been notified of what edition of Apex Sketch v6 you have licenses for. General speaking however, Pro is typically reserved for our Jurisdictional users who require the ability to modify Area Codes to match their counties specific needs/requirements. Standard is what we often refer to as our “Shrink Wrapped” edition that requires little modification and largely used as is by the majority of our users. If you need help determining which edition you should choose, please contact your Apex Representative at 800-858-9958 for assistance.
Registration Process (continued)

Online registration requires:

Email Address
This is the email address you used or entered in when you created your online account. By creating an online account, you should have received a confirmation email with your account information along with additional instructions.

Password
This is the password you’ve chosen for your online account or that was assigned at the time your account was created.

Provided, you’ve input the correct login information and you have available licenses, you will see the “Registration was Successful” message as shown to the right. Click (or Tap) Continue and the program will launch.

Note: If you received any errors, you’ll be provided with a description of the error that occurred along with options to help you through the registration process.

Try Again
This option allows you to “try again” as you may have input the wrong information.

Manage Account
Manage Account will launch the Apex Web Services (Registration) where you can view your license history, purchase additional licenses and manage existing licenses.

Help
Choose this option if you wish to send Apex an email requesting assistance. This will prompt you for contact information and a brief description of the problem you’re experiencing. An Apex representative will contact you as soon as possible.
Manual Registration

This process requires assistance from an Apex Representative. When choosing this option you will see the following dialog:

Call Apex Software at 888-308-2722 or 800-858-9958 M-F between 8:30am & 5:30pm CST to speak with an Apex representative.

**Step 1**
When prompted, provide the **Serial Number** to an Apex Representative.

**Step 2**
Input the **Unlock Code** as provided by an Apex representative. As you input information, the input cursor will automatically advance between the dashes you see.

After you have input the registration code, click **Submit** and you will be presented with similar results as illustrated for Online Registration.

**Note:** Be sure to launch Apex while your Apex Representative is online so they can troubleshoot any errors that happen to occur.
Apex Sketch User Interface

The Apex User Interface is built for speed and ease of use. Everything you see and use has been designed with your workflow in mind. The graphical work area of Apex is a collection of components that group tools based on their functionality and usability. This chapter will introduce you to the different components of the Apex User Interface and guide you through some Basic Navigation. As you become more familiar with the layout and design of Apex, you’ll find that everything you need is a key press or a mouse-click away.

The Apex Sketch User Interface (UI) offers a familiar look for existing users with a bevy of new features and functionality. If you’re new to Apex, don’t let all the buttons and icons worry you. You’ll soon learn the basics of drawing and see how easy Apex is to use. But before you jump to the tutorials, take a little time to get to know the components that make up the Apex Sketch v6 UI.

Apex Sketch v6 User Interface

1. Ribbon Menu
2. Quick Access Toolbar (QAT)
3. Title Bar
4. Window Controls
5. Panel System
6. Bluetooth & Ink Disabled Indicators
7. Sketch Page Indicator
8. Mode/Heads Up Display (HUD)
9. Zoom & Scale Controls
10. Canvas/View Tools
11. Library Tools
12. Drawing Tools
13. Selection & Pan Tools
14. Drawing Port
The Ribbon Bar
The new Ribbon Bar in Apex Sketch v6 is simple to use, but you need to be aware of a few things in order to get the maximum benefit from this component. At first glance, the menus look no different than any other Windows application.

However, once you access one of the "menus", you'll quickly notice the difference. The ribbon bar has a lot more to offer than traditional pull down menus. All the functions are placed in a horizontal fashion giving access to your tools with minimal intrusion of your work space.

Note: To hide the Ribbon Menu at any time, you may double-click (or double-tap) the menu tab. This places the Ribbon in an alternative mode that will "auto-hide" after you have selected a menu item.

File Menu
The File Menu consists of system type operations that pertain to the actual Sketch Files themselves. This is also where you will find other pertinent functions such Import/Export and Print.

- **New (CTRL N):** Choose this option when you want to begin a new sketch file. This action will immediately open an empty sketch file. If you haven't saved your current sketch file, you will be prompted to save your work before continuing.

- **Open (F2):** Use Open if you wish to open an existing sketch file. Doing so will launch the File open dialog and display the Open Files directory.

- **Save (F2):** When you're ready to save your work, choose this option. If you haven't previously saved your sketch, the File Save dialog will open and display the Save File directory where you will be prompted to give your sketch a name.

- **Save As:** If you'd like to save your sketch file with a different name or save it in different file format such as v5.x for use with Apex v5.x, choose this option.

- **Import:** Allows you to import a file which will take on all the subject information properties as well as the file name of the current sketch you are working on.

- **Export File (CTRL F12):** Export File allows you to save your sketch file with a different name or save it in a different file format such as v5.x for compatibility with version Apex v5.x. You may export your sketch files in a variety of image formats.

- **E-mail Apex:** This option helps to send a message to the Technical Support with any questions you may have.

- **Print:** Print will send your sketch file to the printer of your choice. There are several options to choose from. Print Setup, Page Layout and Print PDF.
File Menu (continued)

Print Preview: This option allows you to preview how your sketch will look when printed before actually sending it to your printer.

Print Options: Choosing this option will open the Printer Setup dialog where you can choose your printer along with other settings pertaining to the printed output of your sketch files.

Page Layout: Page Layout provides several options when running Apex Sketch v6. You may choose from a variety of page sizes and styles to match your own preferences and/or requirements.

Options: Choosing Options from the file menu will open the Configuration & Settings dialog which allows you to tailor Apex Sketch v6 around your own needs and preferences.

Exit: This button will close Apex Sketch v6 prompting you to save your sketch file if you haven’t already done so. If Apex Sketch was launched via integration, you will be returned to the calling application.

Note: You may have noticed the MRU (Most Recently Used) contained within the file menu although it won’t be apparent until you have created/edited a few sketches. The MRU lists the most recent sketch files you were working with, giving you the added convenience of quickly locating and opening them should you need to.

Home Menu

The Home Menu is the “main” menu you will use for most of the operations used within Apex Sketch v6.

Cut (CTRL X): The Cut function removes the selected item from view and stores it in the Windows Clipboard.

Copy (CTRL C): The Copy function works much the same as Cut with the exception that it does not remove the selected item from view.

Paste (CTRL V): Paste will place the object (stored in the Windows Clipboard) onto the drawing port. Paste can be used multiple times as well as a new location (i.e. new page).

Select All (CTRL A): As the name implies, choosing this function will select all items contained within the active sketch page. This function is typically used for global changes (i.e. font or line styles), copy/paste and/or deletion.
**Select:** This function allows you to specify what type of entity to select. Once chosen, all of the entities (with the exception of Select Area) of that type will be highlighted within the drawing port for the active page.

**Select Area:** Allows the selection of a single area contained on the active sketch page. This is helpful with sketches that contain many areas making it difficult to locate the area in question. A list of areas will be displayed to choose from.

**Select All Areas:** This allows you to select all drawn/defined areas contained on the active sketch page. This is helpful when making global changes to line styles, color and/or fill patterns.

**Select All Text Label:** Allows you to select all Text Labels within your sketch. This is helpful when making global font changes and/or mass deletion.

**Select All Dimensions:** Allows you to select all dimensions contained within the active sketch page. Much like Select All Text, this is helpful when making global changes to all of the dimension's font style as well as mass deletion.

**Select All Symbols:** Allows you to select all symbols contained within the active sketch page. When needing to remove symbols from the sketch, this is the quickest approach to selecting them all for deletion.

**Select All Free Form Lines:** This operation will highlight all free form (non-calculation) lines contained within the active sketch page. This is helpful when removing them from the sketch and/or globally changing their line style properties.

**Delete Selected:** Clicking (or tapping) Delete Selected will remove the selected item from the sketch. This function can be performed on single or multi-selected items.

**Undo:** Will undo the last action performed. This is helpful when making a mistake and you’d like to return to the previous state.

**Redo:** This action will Redo the last Undo. For example, if you draw a line and you perform an Undo the line will be removed. Using Redo will redraw the line once again.

**Rotate Sketch:** Although you can rotate individually selected items, Rotate Sketch allows you rotate the entire contents of the active page.

**Draw Color:** When you need to distinguish your current drawing color from other drawn lines, using this function allows you to specify a color you wish to draw. Draw Color is temporary. Once the area is defined, all lines will change to match the area properties contained within the area definition.

**Subject Information:** This function will display the Subject Information pertaining to the current sketch file. This information is typically transferred from the calling application and can also be manually edited if/when Apex Sketch is used in a stand-alone fashion.
View Menu

The view menu contains those functions that primarily have to do with what you see and how you see them in your drawing port. There are also a couple of functions that allow you to physically change the appearance of your user-interface.

Mini-Map: Provides you with an alternative view of your sketch within a separate window. This tool is helpful when needing to work in a "close-up", detailed view of your sketch while maintaining a view of the "overall".

View Calcs: Will open a panel on the right side of the Apex Sketch interface providing a summary breakdown of individual area calculations while totaling Gross Living and Building Areas below. Calculations include Area, Base Area, Factor, Net Area and Perimeter for each defined area.

Previous Page: This option will change views to display the previous page in your sketch file. If no previous page exists, you will be prompted to "insert" a sketch page.

Next Page: This option will change views to display the next page in your sketch file. If no page exists, you will be prompted to "add" a sketch page.

First Page: This option will change views to display the first page in your sketch file.

Last Page: This option will change views to display the last page in your sketch file.

Add Page: This function will add a page to your sketch file immediately after the active page. For example. If your active page is Page 2 of 4 pages, choosing this function will effectively "insert" a new page immediately after Page 2 and advance the display to the new page.

Delete Page: Will remove the active page from the sketch file. All remaining pages will be renumbered accordingly.

Themes: Allows you to choose from three separate themes based on personal preference. However, we have observed that some themes (due to coloration and contrast) are more visible than others in different lighting conditions (i.e. outdoor vs. indoor).

Blue Theme: Will change the interface to display the blue theme.

Black Theme: Will change the interface to display the black theme.

Silver Theme: Will change the interface to display the silver theme.
View Menu (continued)

Window: This allows you to specify a Window size. Although this is not used often, it can be helpful when needing to create a specific size window to sketch in when managing multiple applications at once.

Apply: This function allows you to apply a current setting to legacy sketch files. This is very helpful in keeping all of your sketches uniform and consistent.

Precision and Suffix: This will apply the current suffix settings and precision (decimal places) to all dimensions contained in the sketch.

Area Code Table Settings: This allows you to select all drawn/defined areas contained on the active sketch page. This is helpful when making global changes to line styles, color and/or fill patterns.

Tools Menu

The Tools Menu, contains functions pertaining to program configuration and Bluetooth connectivity.

DISTO Connect: Choosing this option will automatically begin polling for nearby DISTO™ laser meters. Provided your DISTO is equipped with Bluetooth, is on and Bluetooth is activated, Apex Sketch v6 will automatically detect and connect with your DISTO.

Disconnect: Will terminate the Bluetooth connection with your DISTO.

Options: Choosing Options will open the Configuration & Settings dialog which allows you to tailor Apex Sketch v6 around your own needs and preferences.

Help Menu

The Help Menu contains those functions that allow you to view this reference material as well as other helpful options designed to assist you with Apex Sketch v6. If you are unable to find the answers to your questions from this menu, please don’t hesitate to call us at 800-858-9958 and we’ll do our best to assist you with all of your sketching needs.

Reference Guide: This is the option you choose to open the Apex Sketch v6 Reference Guide.

E-mail Apex: This option helps to send a message to the Technical Support with any questions you may have.

Remove License: Choose this option if you wish to unregister Apex Sketch v6 from your current device. This is typically done when changing to new machines and/or managing licenses between computers.

About: Will provide you with helpful information when contact Apex Technical Support. Having this information handy when speaking with an Apex Representative is very helpful.
Quick Access Toolbar

The Quick Access Toolbar (QAT) gives you the flexibility to mix and match your frequently used commands, making them readily available by adding them to this toolbar.

QAT Defaults

If you do not change anything in the QAT, the default commands are as shown below. You may change the QAT to contain virtually any command available in Apex Sketch v6.

Quick Access Toolbar – Defaults

1. Window Controls  
2. Open File  
3. Save As  
4. Printer Setup  
5. Print Preview  
6. Undo  
7. Redo  
8. QAT Controls

**Note:** You can learn more about each command in their respective sections under “The Ribbon Menu”.

Accessing the QAT

To begin customizing what commands appear in the QAT, click or tap the drop down arrow provided on the right side of the toolbar.

After clicking the drop down arrow, you will be provided with a list of options pertaining to the QAT and Ribbon Menu.

- **Customize Quick Access Toolbar...**
  
  This option will allow you to choose the commands that appear on the QAT. You can learn more about this in the paragraphs that follow describing “Customizing the QAT”.

- **Place Quick Access Toolbar below the Ribbon**
  
  Choosing this option will place the QAT below the Ribbon Menu. Although this option is available, we recommend leaving this setting as is (Above the Ribbon Menu).
Accessing the QAT (continued)

Minimize the Ribbon

To hide the Ribbon Menu at any time, you may select this option or double-click (or double-tap) the menu tab. This places the Ribbon in an alternative mode that will “auto-hide” after you have selected a menu item.

Customizing the QAT

![Customize Quick Access Toolbar](image)

**File Category:** Choose the category that contains the function or command you wish to add to the QAT.

**Command List:** This window lists the commands available for the selected category. Click to highlight a command.

**QAT Location:** Checking this option will place the QAT below the Ribbon Menu. We recommend leaving this unchecked.

**Add Button:** Once a command is highlighted, clicking this button will make it available (displayed) on the QAT.

**Remove Button:** Clicking this button will remove the selected command/function (Active QAT Commands) from the QAT.

**Close Button:** This will close the window performing the same function as the Cancel button.

**Active QAT Commands:** This displays the list of commands that are available (displayed) from the QAT.

**OK & Cancel:** Clicking OK will accept any modifications made. Cancel will discard any changes and close the window.
Title Bar

The Title Bar displays the program edition along with the name of the active sketch file loaded in Apex Sketch v6. This information varies based on the edition of the program and/or how the program was launched.

Program Edition

Depending on your industry, you will see one of the following “Program Names” displayed in the title bar. This information can be helpful when speaking with an Apex Technical Support representative when determining which version of the software you currently have installed.

**Apex Sketch v6 Standard:** This is the most commonly installed version of Apex and provides what we often refer to as “Shrink Wrapped” functionality. This contains many of the same features as the Pro edition but provides limited customization.

**Apex Sketch v6 Pro:** This edition of Apex Sketch is commonly used in industries that require a high level of customization based on their region or location as well as their varying client base. For instance, the Pro edition allows users to tailor the Area Definitions library to match their jurisdictional naming conventions or requirements through integration with their property record management system(s).

**Apex Sketch v6 Metric:** Commonly referred to as our International Edition, Apex Sketch v6 Metric is reserved for those customers who require the Metric Unit of Measure for both sketch creation and Area Calculations.

Directory Path and File Name

When launched in stand-alone mode (aka non-integrated mode), the entire directory path will be displayed in the title bar. If this is a new sketch, you will see “Sketch?.AXZ” where the “?” will be a number that corresponds to the sketch created during the current session. For example. Without closing Apex Sketch, if you create a new sketch (and the current sketch was “Sketch1.AXZ”, the new sketch file name used would be “Sketch2.AXZ”.

**Note:** “Sketch?.AXZ” is intended to be a temporary filename and would typically designate a sketch file that has not been saved. When exiting or creating a new file, Apex Sketch v6 will prompt you to save your sketch file and give it a more appropriate name.

When launched in integrated mode, the path and filename is usually controlled by the calling application. The filename you would see here typically matches the record name or parcel number referenced when Apex Sketch v6 was launched.
Window Controls

The Window Controls in Apex Sketch v6 are no different than most Windows Applications. Depending on how the program was launched (Stand-Alone vs. Integrated), these controls may not always be available. When available, the following is a description of how each button functions.

- **Minimize Window:** Clicking this option will minimize Apex Sketch v6 from view. To reopen the Window, click its program icon from the task bar.

- **Maximize Window:** This option will maximize the Window size to the size of your monitor. Although it may not always be feasible to do so, we recommend this Window setting as it provides the most amount of drawing space.

- **Restore Window:** When maximized, this option is available allowing you to "shrink" the Window to its previous (smaller) size.

- **Close Window:** This is essentially the same as File>Exit which will attempt to close Apex Sketch v6. If your sketch file has not been saved, you will be prompted to do so.

Panel System

The Panel System in Apex Sketch v6 is designed to provide quick and easy access to libraries that allow you to define areas, annotate your sketches and view calculations. Included in the panel system is a special touch panel that allows mobile users to draw floor plans in the field using only their finger to create/verify measurements while on site.
Accessing the Panels
There are couple of ways you can access the panels. The most common method is performed automatically whenever a mode is selected from the Modes Toolbar located to the left of the interface. Secondarily, the panels may be accessed by clicking or tapping the corresponding Tab located to the right of the interface. The following illustrates these methods.

Define Area Mode: This opens the Area Definition Library Panel.

Text Label Mode: This opens the Text Library.

Symbols Mode: This opens the Symbol Library.

View Calculations: This opens the Calculations Panel (see note below).

Touch Mode: This opens the Touch Panel.

Note: The Calculations Panel is not a "Mode", thus does not have a button within the Modes Toolbar. However, it can be opened through the View Calcs button located on the View Menu.

Locking/Tacking Panels Open
By default, the panels are designed to open when clicking (or tapping) or hovering over them and then automatically close once an action has been performed. If you wish to lock/tack the panel to an open state, click (or tap) the “tack” located in the upper right of the panel.

Untacked: This symbol designates that the panel is untacked/unlocked, which will cause the panel to automatically close after an action is performed.

Tacked: This symbol designates that the panel is tacked/locked, which will keep the panel open until another mode is selected and/or is closed by clicking (or tapping) it once again. Tacking any of the panels open will adjust the drawing canvas accordingly along with the sketch.
The Area Definition Panel

This panel is used to apply an Area Definition to a closed shape in order to calculate its area and apply any associated area properties (i.e. Line Styles, Color and Fill Patterns). This panel supports drag and drop by which you can drag Area Definitions into the shape of your choice, drop it and the Calculations will be done instantly. You can learn more about this panel through examples we illustrate in Chapter 4 (Area Definition). What follows is a brief description of the elements that make up the Area Definition Panel.

Expanded Main Area Category: The Main Area Type is the leftmost label in the list (tree). When expanded, a “-” (minus) will be displayed to the left of the label. To collapse a category, click (or tap) the “-” which will remove the sub-areas from display.

Sub Areas: These are the Area Definitions that belong to the Main Area Type and are typically organized in such a manner as they share similar attributes.

Collapsed Main Area Category: When a Main Area Category is collapsed, a “+” (plus) will be displayed which also indicates that Sub Areas exist. To expand a category, click (or tap) the “+” which will display the associated Sub Areas.

Main Area Type: This is similar to the Main Area Categories, but does not have any Sub Area associated as is indicated by the absence of a “+” or “-”.

Apply Button: This is used to apply an Area Definition to a selected shape.

Auto-Post Options: These controls allow you to specify what should appear once the Area is defined.

Auto-Subtract Overlapped Areas: Used with Quick Shapes, this function will automatically subtract the quick shape calculations from underlying areas.

Area Preview: As you select Area Definitions, the Area Preview will update illustrating the Area Attributes that will be applied.

Edit Button: This button accesses the Area Definitions Configuration which allows you to modify existing Area Definitions or create new Area Definitions. You can learn more about this in Chapter 4 which covers Defining Areas.
Text Label Panel

The Text Label Panel provides you with access to your most frequently used labels allowing you to quickly annotate your floor plan sketches. A default set of labels is provided which can be edited to match your requirements and/or preferences. What follows is a brief description of the elements that make up the Text Library Panel.

Text Library Panel

Text Input Panel: The input panel provided is primarily used when the Text Label you wish to use does not exist in the list. This is helpful for placing Text Labels that are rarely used. Otherwise, we recommend adding the Text Label to the list for convenience.

Text Label List: This list displays the labels that are currently contained in your library. This list is always displayed in alphabetical order.

Edit: This is used when editing the list of labels in your library.

Rolodex Control: This set of buttons is most helpful when managing large lists of text labels allowing you to display only those labels that match the filter as designated on each button.
Symbol Library Panel
The Symbol Library in Apex Sketch v6 has undergone a complete revamp to make them easier to use and place as well as render better for more professional results. The Symbols contained in the library are all precisely drawn which will scale to any sketch you create. As you might imagine, they can also be resized and edited to your liking. What follows is a brief description of the elements that make up the Symbol Library Panel.

Symbol Category: This drop down allows you to select a category of Symbols from which to choose. Breaking the symbols up into categories makes the 200+ Symbols far easier to manager. The Favorites category open by default. Knowing this, you may add to or remove symbols from this library to display only those you typically use.

Symbol Library: Once a category is chosen, the list below will populate with the symbols contained within that directory.

Symbol Preview: As symbols are selected as shown by the highlight to the left, a preview of the symbol is displayed at the bottom of the panel making it easier and quicker to verify the symbol you want to use.

Scroll Bar: The presence of a scroll bar indicates there are more Symbols in this category than can be listen in this panel. Use the scroll bar to view more symbols in the displayed category.
Area Calculations Panel

This panel allows you to view the calculations of all defined areas drawn in your floor plan. This is presented in a tree format which can be expanded or collapsed to expose only those elements and/or areas you wish to review. You can learn more about this panel through examples we illustrate in Chapter 4 (Area Definition). What follows is a brief description of the elements that make up the Area Calculations Panel.

**Expand All:** Clicking Expand All will open all additional Area Calculations on the current page and display them in this panel.

**Expanded Area Calcs:** First Floor (as illustrated to the left) is an example of an expanded calculation tree. Base Area, Factor, Net Area and Perimeter are displayed along with the overall calculation.

**Collapsed Area Calcs:** Both of the P/P (Porch/Patio as illustrated to the left) areas are examples of collapsed calculation tree. In this state, only the adjusted calculation will be displayed.

**Collapse All:** Clicking Collapse All will close all additional Area Calculations on the current page and display only the adjusted calculations for each area in this panel.

**Calculation Summary:** Calculation Summary lists the number of defined areas contained on the current page along with the combined calculations for any Living and/or Building areas. In this illustration, both First and Second floors are included in this total. Additionally, since no defined Buildings (typically reserved for commercial purposes) exist, the Summary lists this value as zero.
Touch Panel

The Touch Panel is specifically designed for those who have Touch Only Windows tablets or users who simply prefer the touch method of drawing over pen (inking). You can learn more about this panel through examples we illustrate in Chapter 3 (Drawing Methods). What follows is a brief description of the elements that make up the Touch Panel.

1. **Distance Display**: As you input information from the number pad (8), the information is displayed in this field. This field also displays Turn information.

2. **Angle Left & Right**: Used in the “Turn” function for drawing angles, these buttons allow you to specify the direction of the angle. You can learn more about the Turn feature in Chapter 3 (Drawing Methods).

3. **Curve Left & Right**: Allows you to create a curve from the active line. Each tap will “grow” or “shrink” the curve depending on the direction of the curve. You can learn more about the Curves in Chapter 3 (Drawing Methods).

4. **Shift & Control**: These are modifier buttons that assist you with drawing and/or alignment functions. You can learn more about Shift & Control in Chapter 3 (Drawing Methods).

5. **Delete & Insert**: Delete and Insert allow you to delete lines to correct mistakes and insert those you previously deleted. You can learn more about Insert & Delete in Chapter 7 (Editing Functionality).

6. **ENTER Button**: ENTER is used to “accept” and anchor the line once you are satisfied with its dimension and/or orientation.

7. **Direction Pad**: The Direction Pad is typically used in conjunction with the number pad for distance and direction drawing. However, when no value is input, pressing an arrow button will move the cursor a single unit in the given direction. The center button in the Direction Pad is Jump which will move the cursor to the nearest endpoint of a line.

8. **Number Pad**: This pad is used to enter measurements typically followed by a direction specified on the direction pad. As you tap the number pad, the Distance Display (1) will show the value.
Bluetooth Connection and Ink Disabled Indicators

Bluetooth & Inking (disabled) Indicators provide the user with feedback regarding their current state. The “ON” state for either indicator is designated by a color glyph where the “OFF” state is designated by a dithered glyph.

- **Bluetooth Indicator:** Apex Sketch v6 supports Bluetooth connection with DISTO Laser Meters (Leica GeoSystems). If a connection is established the indicator will change from dithered to color as shown.

- **Ink Disabled Indicator:** When Touch is enabled through Option, Inking (active pen) is disabled as a convenience to the user. When this occurs, the glyph will change from dithered to color as shown to the left.

Sketch Page Indicator

The Sketch Page Indicator offers more than visual feedback of the page you’re working with. It’s also how you navigate, insert and add new pages. Apex Sketch allows unlimited number of pages per sketch file. Whether it’s splitting multi-story buildings or managing your scale by separating structures across multiple pages, this extended functionality provides you with the flexibility you need when laying out your floor plans and property sketches.

![Sketch Page Indicator]

1. Previous/Insert Page
2. Active Page
3. Next/Add Page
4. Total Pages

Adding & Inserting Pages

Whenever you wish to add or insert a page to your sketch file you can do so through View>Add. However, while navigating, when you’ve come to the first or last page in the sketch, continuing to navigate left will prompt you to insert a page and navigating right on the last page will prompt you to add a page.
Mode/Heads Up Display (HUD)
The HUD in Apex Sketch v6 gives you visual feedback pertaining to the mode you’re currently in as well as additional information corresponding to distances input and other features such as “Turn” when creating angles. The following illustrates what the HUD will display in conjunction to the mode or input.

<table>
<thead>
<tr>
<th>Mode/Input</th>
<th>Displayed in HUD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td>Fence</td>
</tr>
<tr>
<td></td>
<td>Lasso</td>
</tr>
<tr>
<td></td>
<td>Pan</td>
</tr>
<tr>
<td></td>
<td>Draw Area</td>
</tr>
<tr>
<td></td>
<td>Draw Interior</td>
</tr>
<tr>
<td></td>
<td>Draw Area</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
</tr>
<tr>
<td></td>
<td>Define</td>
</tr>
<tr>
<td></td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td>Draw Area</td>
</tr>
</tbody>
</table>
MODE/Heads Up Display (continued)

<table>
<thead>
<tr>
<th>Mode/Input</th>
<th>Displayed in HUD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GeoReference Points</td>
</tr>
<tr>
<td>24.5</td>
<td>24.5</td>
</tr>
<tr>
<td>30, L, 90</td>
<td>30' line at 90° Left</td>
</tr>
</tbody>
</table>

**Zoom & Scale Controls**

Zoom & Scale may seem redundant on the surface, but each function are separate and different in their own regard. To make things more clear, Zoom should be considered a “View” property and Scale be considered a “Size” property.

**Zoom Slider**

Located at the bottom left of the interface, the Zoom Slider is used to increase or decrease your view in the drawing port. Zooming in will make the sketch larger giving you a close-up view how much you can see in the Drawing Port. Zooming out will make the sketch smaller allowing you a more global view of your sketch the further you continue.

1. **Zoom Out Button**: Pressing this button will Zoom Out (make smaller) in increments of 10%.
2. **Zoom Slider Control**: Dragging this control will increase (step) in 10% increments. (10% - 1000%)
3. **Zoom In Button**: Pressing this button will Zoom In (make larger) in increments of 10%.
4. **Zoom Percent**: This displays the current Zoom percentage.

**Note**: Zooming in or out can also be accomplished by rolling your mouse forward (Zoom In) and backward (Zoom Out). In order to do this, you must be in Select Mode or you drawing cursor must be in an “Up” State (not drawing).
Zoom & Scale Controls (continued)

Scale Control
As we’ve mentioned, Scale does not affect your Zoom level, but it does have an impact on the “Size” of the sketch which does appear larger or smaller depending on the scale you specify. While on screen, Scale isn’t much different than Zoom. However, when it comes to output (i.e. printing) the use for scale becomes more evident.

![Scale Control](image)

1. **Unit of Measure**: This display indicates which unit of measure is being applied to your sketch. In Imperial the ratio is 1 inch to feet. In Metric, this is 1 meter to meters.

2. **Scale Input Field**: Input the number of units (feet or meters) you wish to rescale your sketch.

**Note**: Keep in mind, the larger the number you input, the smaller the sketch will appear in your drawing port. Conversely the smaller the number, the larger your sketch will appear.

Canvas/View Tools
Like the Zoom & Scale Controls, these tools also allow you to change what you see on your screen. The following is a description of each of these tools.

- **Center (C)**: This function will center the sketch in the Drawing Port. This is convenient while drawing as it allows you to quickly adjust your sketch whenever you draw off of the drawing port keeping it in view.

- **Center & Fit (Shift + C)**: Although the Center function is valuable, sometimes, centering your sketch isn’t enough as your sketch may be too large (or too small) in its current size. This function will Center and Fit the sketch (by its extents) in the drawing port bringing the entire sketch into view.

- **Grid On/Off (G)**: This allows you to show or hide the grid in the drawing port. Although the grid is an excellent tool for viewing alignment, you might find (because of the drawing and alignment tools available in Apex Sketch) the grid to be unnecessary.
**Library Tools**

The Library Tools allow you access to the Libraries available in Apex Sketch. The majority of these tools will open the library through the panel system on the right (i.e. Text and Symbol Library) where others (i.e. Smart Labels) open dialogs you'll interact with. The following is a brief description of each of the Library Tools.

**Area Definition Library:** This tool will open the Area Definition Panel from which you use to detect shapes and apply area attributes along with their calculation. *You can learn more about this tool in Chapter 4 – Area Definition.*

**Text Library:** Pressing this button will open the Text Library Panel allowing you to annotate your sketches with (say) room labels and/or other notes.

**Symbol Library:** This function will open the Symbol Library Panel where you can choose from over 200 individually drawn and scaled symbols to add to your property sketches for additional detail.

**Touch:** This will open the Touch Panel which is designed for mobile users who wish to draw in the field with their Windows Tablet. *You can learn more about this tool in Chapter 3 – Drawing Methods.*

**Sketch Geo-Referencing:** This tool does not open a dialog, but does launch the Geo-Referencing process by which you will choose locations in your sketch to reference data from your GIS System. *You can learn more about this tool in Chapter 6 – Data Collection.*

**Drawing Tools**

For obvious reasons, this set of tools are the most used and important for the construction of your property sketches/floor plans. The following is a brief description of each of these tools.

**Draw Exterior:** This Drawing mode allows you to draw lines (typically exterior) which will be used for calculation purposes. Simply put, if you want/need to calculate the shapes you draw – this is the tool you should use. *You can learn more about this tool in Chapter 3 – Drawing Methods.*

**Draw Interior:** This Drawing mode allows you to draw lines (typically interior) which will be used for illustration (non-calculation) purposes. This line style is generally used to depict interior floor plans, fence lines, property lots, streets, etc.

**Insert Vertex:** A Vertex in drawing terms is a “point” in the sketch. This drawing mode allows you to “break/divide” lines and shapes using the same drawing methods for creating any line. *You can learn more about this tool in Chapter 3 – Drawing Methods.*

**Quick Shape Tool:** Apex Sketch currently supports rectangles through the Quick Shape tool. This unique method of drawing allows you to quickly drag out a rectangle and specify its length and width dimensions versus draw each side of the shape individually. *You can learn more about this tool in Chapter 3 – Drawing Methods.*
Selection & Pan Tools
These tools allow you to select items in your floor plan sketch or pan around your sketch bringing a specific section of your property into view. The selection tools also allow you to access the new Properties Tab which will appear once an object has been selected giving you a quick way to edit specific elements pertaining to that object which we call "Context Editing". The following is a brief description of each of these tools.

**Selection Tool:** This is generally used for selecting individual or multiple items for the purpose of editing them in some fashion. With the mouse, you must press (and hold) **CTRL** for multiple item selection where with a pen or finger, selecting multiple items is inherent.

**Fence Tool:** This tool allows you to drag a fence (rectangular) around objects in your sketch. Once you release your mouse button or lift your pen/finger, all objects fully contained in the fence will become selected.

**Lasso Tool:** Like Fence, the Lasso Tool allows you to select multiple items but with far more precision. Simply draw around the items you wish to select and anything fully contained within the “lasso” will become selected.

**Pan:** This function allow you to move your drawing canvas (along with the sketch). This is particularly helpful when needing to view a specific section of your sketch while zoomed in or to simply move your sketch to create more drawing space.

Drawing Port
The Drawing Port is the largest area of the UI and is the main work area for creating your sketches. Throughout this reference guide, we may call it the “Drawing Canvas” or “Sketch Area” but they are all referring to the same work area.
Options & Settings
Configuration & Settings is accessed through **Tools>Options** where you will find several configuration options that you can change to match your own preferences and/or requirements. The following is a general description of all the functions contained within the Settings Dialog.

Common Settings Dialog Properties
Before diving into each Tab within the dialog we need to point out the common elements of this dialog. Each of these controls are visible regardless of the active tab displayed.

**Category Tab:** Choose the category of Settings you would like to display from those provided.

**Restore Defaults:** This option allows you to reset ALL categories to their original settings. These settings are the installation defaults for Apex Sketch v6.

**OK Button:** Pressing OK will apply the changes made and close the dialog. Keep in mind, some changes will require a program restart to take effect (i.e. Unit of Measure).

**Cancel Button:** The Cancel button will abort any changes made in Settings and close the dialog.

*Note:* Before resetting the defaults, make sure you have saved any changes to your existing sketch. If you have any concerns about doing this, give us a call (800.858.9958) and we will guide you through the process.
Options & Settings (continued)

General Settings

**Input Options:** Designed with the mobile user in mind, these settings allow you to turn on Gestures and Touch Screen. Gestures require an active pen and include functions such as Undo/Redo, Line Direction, etc. Touch Screen provides access to the Touch Panel and is generally reserved for Touch devices, although may also be used with a pen.

**Unit of Measure:** This allows you to change between Imperial (Feet and Inches) and Metric (Meters) Units of Measure.

**Decimal Precision:** This setting allows you to specify how many decimal places you would like to display for dimensions and posted area calculations. Most common for users in the US is 1 decimal, but will support up to 4.

**Dimension Format:** Allows you to choose how your dimensions will display for each line between Engineering (Decimal) and Architectural (Feet & Inches).

**Ortho:** Ortho pertains to the snap angle when drawing with a mouse. By default, this is set to 5° (Degrees) and can be set as high as 45° or Off (not recommended) altogether.

**Notifications:** When Geo-Referencing your sketches, you are normally prompted that Apex Sketch v6 will “minimize” once you’ve selected the second location. This option enables you to turn this notification Off/On.
Options & Settings (continued)

Display Settings

Alignment Indicators: These settings allow you to control the visual elements of alignment. This is also where you can turn alignment indicators On/Off.

Grid: Like the Grid On/Off button on your interface, you can enable the Grid through settings as well. This group also allows you to change the visual elements of the Grid and how it will appear when enabled.

Minimum Dimension Properties: You may have notices that when zooming in or out, the dimensions of your sketch also scale and at certain levels difficult to read. This setting provides you with control to “lock” the minimum dimension size when zooming out. When this is enabled, the dimensions will not shrink past the specified font size ensuring you can always read your dimensions.

Hardware Settings

DISTO Discovery: Allows you to automatically poll for Bluetooth DISTO devices or manually specify a COM port to communicate with the DISTO. We recommend the automatic discovery as it’s the easiest way to connect with your DISTO device.

Note: This is NOT where you connect with your DISTO, rather where you setup how you will establish connection. You connect with your DISTO through Tools>Connect.

Configuration: Allows you to handle the data received from your DISTO. Rounding can be set to the nearest half, hundredth, tenth and whole unit. There are two Drawing Modes as well. Interactive allows you to specify distance and direction if your DISTO has directional keys and Edit in Place (recommended) which allows you to specify the dimension of the active line.
Options & Settings (continued)

System Settings

Auto-Save: Apex Sketch will automatically save your files for emergencies such as loss of power, system crash, etc. Use this setting to turn On/Off and also how often Apex should save your sketch file.

Image Files: When using Export to save your sketch files, it will make them according to the size and Color depth you set here. Higher Size setting and Color depth will create larger (higher quality) images.

Area Code Table: This is where you can specify the location of the Area Code Table (AXWDDA1.XML). This is helpful when working in a server environment where everyone is accessing the same Area Definition Table.

Font Settings

Font Settings: This tab allows you to set the default Font Size and Styles for Dimensions, Text Labels and Auto-Post Labels.
Area Line Properties: Use this setting to specify the default Line Color and Thickness when creating lines.

Note: For Area Line Properties, this is a visual ONLY type of setting. When the Area is defined, the Line Style Properties set within the Area Definition will be applied. The purpose of this setting is to allow users to specify a color and thickness that might be more suitable for their viewing needs/preferences.

Interior Line Properties: This setting allows you to specify the default Line Color and Thickness for Interior Lines. Unlike Area Line Properties, these colors will not be affected by area definition and will retain the properties you choose for this setting.
Apex Sketch v6 Drawing Methods

As with any program, in order to use it properly, you need to first learn the basics. This chapter will introduce you to drawing in Apex Sketch which currently supports 5 different methods of input including Keyboard, Mouse, Active Pen, Touch and DISTO. In this chapter we’ll draw a basic sketch covering lines, angles and curves.

For your convenience, we will break this chapter into sections to cover each drawing method separately. Look for these symbols at the top of each page going forward which designate the drawing method being covered for that section.

Keyboard & Mouse

Active Pen

Touch

DISTO

Apex Sketch v6 is designed to be a “One Size Fits All” program that supports Windows based platforms addressing both Desktop and Mobile needs/requirements. You no longer need to maintain two separate licenses (and programs) to accomplish your tasks in your office or in the field. In fact, if you’re running Apex Sketch v6 on a PC that doubles as your desktop and mobile device, Apex is ready when you are without having to change modes.

What might be different for you however, is the way you draw in the field versus your office. The transition is simple as are the techniques by which you will create your floor plan sketches. This chapter will guide you step-by-step through each process mentioned above.

**NOTE:** As you progress through this chapter, areas highlighted in this fashion are designated “action” sections prompting you to perform the specified commands should you choose to follow along in Apex Sketch.
Keyboard & Mouse Drawing Method

Keyboard and mouse are typically used in conjunction with one another and although there are several ways to accomplish the same task, we’ll focus on the most common uses in this section. Before we get started however, there are a couple of important topics we need to cover.

Define Area Process
Although much of the drawing process will be familiar to existing users, we’ve added additional flexibility that may take some getting used to. For instance, you no longer need to define the area before drawing the shape. Whether you’re drawing from a set of plans and hand drawings or drawing on site, the process is the same. We’ll cover Area Definition in Chapter 4.

Drawing Modes
Before you can begin drawing you must first be in a drawing mode. When you launch Apex Sketch v6 this is the default mode the program is set to so you can begin drawing immediately. To activate a drawing mode, simply click on Draw Exterior or Draw Interior located in the toolbar on the left side of the user interface.

Draw Exterior: This Drawing mode allows you to draw lines (typically exterior) which will be used for calculation purposes. Simply put, if you want/need to calculate the shapes you draw – this is the tool you should use.

Draw Interior: This Drawing mode allows you to draw lines (typically interior) which will be used for illustration (non-calculation) purposes. This line style is generally used to depict interior floor plans, fence lines, property lots, streets, etc.

Now that you have a Drawing Mode selected, your cursor will change to a Crosshair which will change in appearance depending upon its state.

Cursor States
Part of our improvement to provide a “Draw First” paradigm is the added ability to draw wherever you wish, whenever you wish. This freestyle approach however requires some visual cues that indicate whether the pen is “Up” or “Down”.

Pen Up: The basic rule of thumb about Pen Up is when it is in the state, lines will not be drawn. This allows you to move your cursor wherever you wish. This is helpful when encountering difficult areas of your property and need to come back or tackle this problem from a different angle. It’s also useful when needing to draw other areas as you come to them whereas in previous versions you had to complete the current area prior to doing so.

Pen Down: Pressing \[ \text{Enter} \] or clicking the mouse (left button) while in Pen Up state will cause the cursor to highlight/fill in green indicating that any cursor movement from this point will draw a line. The same is true regardless of the Drawing Mode (Exterior or Interior). To pick the pen up again, all you need to do (with no line drawn) is press \[ \text{Enter} \] or click your mouse button once again.

Note: Pen Up and Pen Down can be performed only while in a Drawing Mode. Continuing to press \[ \text{Enter} \] will pick the Pen Up or place the Pen Down (with no line drawn) in the same fashion as Free Form lines in previous versions.
Drawing with Mouse & Keyboard
Apex Sketch v6 draw in several fashions with the mouse and keyboard allowing you to mix and match their uses based on your own style of drawing. The following is a brief description of each of the drawing inputs you can use to create your floor plans.

Mouse Drawing
Apex Sketch allows you to draw with the mouse by simply clicking the mouse button (left button) and move your mouse in the direction you wish to draw.

Drawing with Arrow Keys
You can draw with your arrow keys by pressing the direction you wish to draw. With each press of an arrow key, your drawing cursor will move 1 unit in the specified direction. If you hold down an arrow key, the cursor will travel in the specified direction until you release the arrow key. Holding \[ \text{Shift} \] while pressing an arrow key will also draw in “tenths”.

Drawing with Distance & Direction with Keyboard
Distance and direction is probably the most popular way users draw in Apex products today and is arguably quicker than most of the other methods. To do this, simply enter a distance on the number pad (ten-key) or the number row and then specify a direction with your arrow keys. The cursor will travel the distance input and your line will be drawn.

\[ \text{Note: All of the above descriptions assume your cursor is in a “Pen Down” (green cursor) state. Otherwise, the cursor will move as described, but no line will be drawn.} \]

Drawing Techniques (Keyboard Only)
Using the keyboard, Apex Sketch v6 allows you to draw your lines in a couple of ways to match your data or preferred method of measuring.

Engineering Input
Engineering input, the most commonly-used method, refers to a decimal unit of measure (i.e., 25.5). When inputting a distance, type in the decimal measurement and then press one of the direction keys. For example, to draw a line that was measured to be 25.5 feet to the right, you would input:

\[ 2 \ 5 \ 5 \ 5 \ \text{→} \]

\[ \text{Note: Although you could draw with your mouse, sketching in this fashion is much more efficient and precise than using your mouse. With practice, Engineering Input will become second nature.} \]
Keyboard & Mouse Drawing Method (continued)

Architectural Input

This drawing technique will be most helpful for those that work off plans & specs that are created with feet & inches. Architectural Input allows you input your measurements just as you see them rather than converting each dimension to decimal equivalents ultimately reducing the potential for error.

When using this input method, rather than using the . as your separator, you would use the (TAB) key to denote feet & inches. For example, to draw a line that was measured to be 25’ 8" to the right, you would input:

![Image showing input of 25.7 feet]

**Note:** Apex Sketch automatically converted the feet & inches to the decimal equivalent (default). If you wish to maintain a feet & inches display for dimensions you will need to change the settings through Tools>Options>General Tab>Dimension Format.

You can also input fractions of inches in a similar fashion. To draw a line equivalent to 25’ 8 & 1/2" to the right (twenty-five feet 8 and one-half inches), the input is:

![Image showing input of 25.7 feet and 1/2 inch]

As described in the previous chapter, the HUD (Heads Up Display) located at the bottom of the Apex Sketch interface is tracking your input and displaying your data entered for easy/quick verification. After you input your data the following is what the HUD looks likes.

![Image showing HUD with 25' 6 1/2"

**Note:** It’s not necessary to choose a particular input mode since Apex determines the proper mode based on your method of input. What is important to remember is how to how to input the measurements in a given mode (i.e., which keystrokes to use).
Keyboard & Mouse Drawing Method (continued)

Drawing Your First Shape

We'll add more functions and capabilities as we move through the rest of this chapter. For now, we'll focus on the steps necessary to draw your first line and shape. As discussed, there are several ways to draw with the mouse and keyboard, but we'll focus on the method most commonly used – distance and direction.

Make sure you are in Draw Exterior Mode by clicking it on the toolbar to the left.

Press `Enter` or click your left mouse button to place the Pen Down.

Your screen should look similar to the following:

Pen Down

Note: Unlike when drawing with pencil & paper, you don’t need to worry with where to begin. In Apex Sketch, simply choose a place to begin and begin drawing. You’ll learn more how to manage your sketch later in this chapter.
The first line in our sketch is **30 feet to the right**. To draw this, input the following:

```
3 0 →
```

**Note:** Pressing `enter` anchored the line which will also automatically anchor the dimension (by default). If you wish to manually place dimensions you may do so through *Tools* > *Options* > *General Tab* > *Auto Placement*.

Keep in mind, pressing `enter` again at this point, will pick the pen up because nothing else has been drawn. If you’re accustom to pressing `enter` twice to anchor the line and dimension in previous versions, doing so will pick the pen up when you may not have intended to. Let’s continue with the next line, which is **20 feet down**.

```
2 0 ↓
```
At this point your sketch should look similar to the following:

Now that you have the hang of drawing straight lines, let’s draw a few more by inputting following measurements and directions:

27 feet to the right, Anchor the line (ENTER)

28.5 feet down, Anchor the line (ENTER)

10 feet to the left, Anchor the line (ENTER)

Note: Depending on your resolution, your cursor may have moved off of the drawing port causing the drawing port to Auto-Pan to follow the drawing cursor. We’ll discuss this next.
After drawing the previous lines (depending on your resolution), your screen may look similar to the following:

**Auto-Pan Functionality**

When we drew our sketch at this resolution and input the 28.5 foot line down, the drawing port changed to display what you see in the illustration above.

Had you been drawing with pencil & paper, you’d be faced with the decision to redraw your sketch, flip to the back side or tape on an additional sheer of paper to continue! Apex Sketch is designed to reduce this frustration by providing a canvas that grows to accommodate anything you draw.

**Auto-Pan**

Apex Sketch v6 will automatically pan the drawing port whenever you draw outside of its boundaries. This is done to always keep your drawing cursor in view. This is helpful when drawing large properties where viewing the entire sketch at once would make it too small to see its dimensions.

**Center Sketch and Center & Fit**

If you wish to bring your sketch into view, press `C` and your drawing port will adjust and display your sketch centered within its boundaries. However, there may be times when centering, the sketch is too large for the drawing port. Pressing `SHIFT C` will Center & Fit the sketch on the canvas.

**Note:** You can use the Center command at any time keeping your sketch centered within the drawing port.
Keyboard & Mouse Drawing Method (continued)

We'll center our sketch now by pressing C and if you're following along, your screen should look similar to the following:

![Sketch Centered](image)

Helpful Hint
During the course of drawing areas you may notice the "poly" (attached lines) you are currently working with is highlighting in fuchsia (pink). You may also notice the POB (Point of Beginning) is also designated by a pink circle endpoint. This is done by design to give you visual cues of the active shape you are constructing.

Pink is Good
When the entire polyline you are working on is green, it indicates that you have no "breaks" in your shape. This is an important concept as when there are breaks your shape may not define properly. Had the poly in the example above had breaks (gaps) you might see a relocation of the POB or the poly itself would not be green throughout.

Note: When the entire shape is not pink, it’s not always a sign of a problem. For instance, when drawing an enclosed shape that is attached to another area, ONLY the lines necessary to close the shape may be pink. This will become clearer as we continue with this example.
Keyboard & Mouse Drawing Method (continued)

Drawing a Bay Window – Introduction to Rise & Run
Apex Sketch v6 allows you to draw angles using Rise & Run measurements. In our example the Rise & Run measurement is 5 feet by 5 feet (5’x5’). You can easily construct this in Apex by drawing the following:

DON’T PRESS ENTER (YET)

Pressing ENTER will accept your changes.

Stacking Dimensions
Rise & Run is an example of Stacking Dimensions by which you manipulate a line’s length and orientation by inputting multiple measurements and distances to create angled walls and adjusted lengths. At this point, your screen should look similar to the following:
Angle Drawn & Anchored

Keyboard & Mouse Drawing Method (continued)

Let's continue with our sketch by completing the rest of the bay window. Do this by inputting the following measurements and directions:

1 1 ← ENTER 11 feet to the left, Anchor the line (ENTER)

5 ← 5 feet left, Don’t press ENTER

5 ↑ ENTER 5 feet up, Anchor the line (ENTER)

1 0 ← 10 feet left, Anchor the line (ENTER)

Note: You’re not required to enter Rise or Run in a specific order. Just as the above angle was drawn by inputting 5 feet left and 5 feet down, the same angle could have been made by inputting 5 feet up and 5 feet left.

Your screen should look similar to the following:

Bay Window Complete
Keyboard & Mouse Drawing Method (continued)

Direct Angle Input – “Turn”
Small angles are fairly easy to measure and draw. However, there are times when you may encounter angled walls where obtaining the Rise & Run measurements can be quite a challenge.

The wall we would like to draw measures 17’ in length and angles to the right at 45°.

Elements of an Angle

The Turn feature allows you to draw angles by inputting the length of the wall, the direction it “turns” (in relation to the last wall and the deflection angle. To draw this line in Apex Sketch, you would input the following commands:

1 7

17 feet, Don’t press ENTER

R

Turns to the Right, Don’t press ENTER

4 5

45° angle

Look at your HUD at the bottom of your UI. As you entered input the above commands, this information is updated to reflect your input.

17’ line at 45° Right

Press ENTER to accept the input and draw the wall.

Press ENTER once again to anchor the wall.

Note: When using the turn feature, the HUD will default to 90° immediately after specifying a direction (Right or Left). To change this to something other than 90°, simply input the angle and it will overwrite the default. This is done by design to allow you to quickly accept the 90° angle (most common) without having to input it.
Keyboard & Mouse Drawing Method (continued)

Your screen should look similar to the following:

![Angle Drawn & Anchored (Turn Feature)](image)

**Note:** The Turn Feature also accounts for angles drawn off of angled walls making it uniquely tailored to the way you measure and create floor plans. No additional math necessary to adjust for existing angles is necessary. Simply input the measurements as you’ve gathered them and let Apex Sketch do the rest.

**How do I determine the angle of the wall without Rise & Run?**

There are several tools available on the market today to help you measure angles. We recommend using the Mite -R- Gage® as it’s made of durable material (Lexan) and has extended arms that aid in the accuracy of your measurements.

Contact us **(800.858.9958)** if you’re interested in learning more about this measuring device.
Keyboard & Mouse Drawing Method (continued)

Alignment
While drawing you may have noticed “dots” and dashed lines when moving your cursor with your mouse or keyboard entry. These are alignment indicators that give you instant feedback when coming in alignment with other points and lines in your sketch. The dots designate endpoints your cursor location is in alignment with and the dashed lines draw back to those points making it clear the cursor is vertically and/or horizontally aligned with the highlighted point(s).

There are several alignment tools that ensure your areas are attached and/or “squaring” properly. As with previous versions, Apex Sketch v6 has various forms of alignment and snapping features at your disposal. The following are the alignment functions of Apex Sketch when using Keyboard & Mouse.

Mouse Movement

**Auto-Alignment:** While moving your mouse, you will notice the drawing cursor automatically snaps to endpoints of lines and when it comes in alignment with other points.

**Jump:** Will jump to the nearest endpoint. It is recommended that you use this function for attached areas and/or continuing with partial areas to ensure the lines are truly attached versus the appearance that they are.

**Align:** Ctrl is a modifier key used to snap to alignment when used in conjunction with arrow keys. When pressing Ctrl and an arrow key, your drawing cursor will travel to the next point of alignment in the specified direction.

**Intersect:** Ctrl, Shift and an arrow key allow you to travel in the direction specified until the drawing cursor intersects with another line, bypassing all other alignment points that may exist along the way.

**Note:** Becoming proficient with your alignment tools will save you a lot of time when creating your floor plan sketches. We recommend practicing with these tools until you get a good feel for how they work and the best situations you should use them.

Alignment Styles
You can adjust the appearance of alignment in Apex Sketch through Tools>Options>Display Tab. You can turn them on or off, change the style from Dashed to Solid and also adjust the color if the default is not suitable for your preferences.
Let’s make use of our first alignment function to bring the drawing cursor in alignment with the (POB) Point of Beginning. Perform the following:

- **CTRL** Align left,
- **ENTER** Press **ENTER** to anchor the line.

Your sketch should look similar to the following:

![Sketch Alignment Example](image)

**Alignment**

**Importance of Using Alignment Tools**

Using alignment is important when squaring your areas. Although you could have input 4.0 to the left, using alignment here (especially off of an angle as illustrated), this ensures that your sketch aligns perfectly (mathematically). It’s likely that the 4.0 dimension is rounded in accordance with your decimal precision and NOT actually 4.00 mathematically. In this case, the same will also be true with the closing dimension. Don’t worry though, Apex Sketch uses the actual geometry to derive its calculations (not the rounded/displayed dimensions) giving you extremely accurate results. If you would like to see a more precise dimensions displayed we recommend changing the decimal precision (decimal places) under Tools>Options>General (Tab).
Completing Areas with Auto-Close

Auto-Close is an important feature that allows you to close the areas you draw. However, due to the new drawing engine of Apex Sketch, you may find that you don’t use it as much as you used to.

Let’s close the area we’ve been working on by pressing \text{A}.

Congratulations! You’ve drawn your first area in Apex Sketch v6. It hasn’t been defined or calculated just yet, but you’ll do that in the next chapter (Area Definition). For now, let’s continue to create the lines in our sketch that make up the other areas of the property.

\textbf{Note:} When you auto-close an area, the color changes from green to the default line color. The pen changes from green to gray indicating that it is in “Pen Up” allowing you to move your cursor to another location.

Saving your Sketches

You can save your work at any time (including open areas) by choosing File>Save and giving your sketch file a name. For the first time, Apex Sketch will default to the My Sketches directory in your documents folder. Subsequent saves will default to the last directory you saved/opened sketches.

Export your Sketches

You can also export your sketches in a variety of formats including .XML, .BMP, .GIF, .JPG, .PNG, .TIF and .AX5 which is the previous version of Apex.

\textbf{Note:} Apex Sketch v5 can open Apex Sketch v6 files.
Drawing Attached Areas

In previous versions, you would define any attached areas first and then establish a point of beginning. As we did with the first area we drew, we will skip the define area process and simply draw more lines that make up additional areas. For this example, we’ll pick up where we left off on our previous sketch. To do this, we will use one of our alignment functions we call Jump. Place your cursor near the point as illustrated in the following screenshot.

Positioning Cursor Prior to Using Jump

Press J and your cursor will jump to the end point as shown to the right. This ensures the cursor is precisely where you need it to be for attachment.

Press ENTER to put the pen down and establish a point of beginning. The cursor will change to green indicating you’re ready to draw.
17 feet to the right. Anchor the line (ENTER)

Your screen should look similar to the following:

**Drawing Curves**

Curves are another encounter that can turn a beautiful day into a nightmare. On one hand, they’re not always easy to measure and on the other you need to draw it on your computer! Don’t worry. Apex makes drawing curves a breeze and in this example, we’ll cover everything you need to gather to draw them accurately. Before we begin the curve it’s important to understand all the components that make up the curve with regard to Apex.

First Line of Attached Area

Elements of a Curve
Keyboard & Mouse Drawing Method (continued)

Degree of Curvature (Arc Angle)
Also know as Degree of Curvature takes into account “how much of the circle” in degrees does this arc measure to. You won’t need to draw circles to discern the curvature. You measure other key elements (Arc Length, Chord Length, Arc Height) to achieve that.

Chord Length
Chord Length is the straight measurement between the endpoints of the curve. The Chord length is essential in determining the Arc Angle when using the Curve Solver as without it you won’t have enough data to build the curve accurately.

Arc Length
This is the most common element of the curve that you’d measure in the field since most of your perimeter measurements are taken from the outside of the property. You’ll find that the majority of the time, the curves you encounter are simply rounded corners (90°) that are fairly easy to measure. However, there may be times when the Arc Length is extremely difficult to obtain and you must rely on other measurements to help you construct the curve properly.

Arc Height
Arc Height is the distance from the center of the Chord to the Apex of the Arc. This measurement is crucial in determining the Arc Angle if you have the Chord Length, but are unable to measure the Arc Length.

Degree of Curvature [D] or Arc Height [H]
Apex Sketch allows you to draw your curves by setting the “mode” you are drawing in. When you press [D] (once) when bowing the curve it will allow you to adjust the Degree of Curvature (default). Pressing [H] (once) will change the mode to Arc Height allowing you to modify your curve by the Arc Height measurement.

To draw curves in Apex Sketch v6 with Keyboard & Mouse, you can choose from the following methods:

<table>
<thead>
<tr>
<th>Action/Key Press</th>
<th>Function</th>
<th>D (Degree)</th>
<th>H (Height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Wheel Forward</td>
<td>Bow Curve Left</td>
<td>15°</td>
<td>1 unit</td>
</tr>
<tr>
<td>Mouse Wheel Backward</td>
<td>Bow Curve Right</td>
<td>15°</td>
<td>1 unit</td>
</tr>
<tr>
<td>+ (Ten Key)</td>
<td>Bow Curve Left</td>
<td>15°</td>
<td>1 unit</td>
</tr>
<tr>
<td>- (Ten Key)</td>
<td>Bow Curve Right</td>
<td>15°</td>
<td>1 unit</td>
</tr>
<tr>
<td>Context Edit</td>
<td>Edit Curve Elements</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Keyboard & Mouse Drawing Method (continued)

Curve Modifiers (Shift & Ctrl)
When performing any of the functions to create a curve, using the `Shift` and `Ctrl` keys can aid you in the accuracy based on what elements you are able to measure based on Degree of Curvature or Arc Height.

<table>
<thead>
<tr>
<th>Key Press</th>
<th>Function</th>
<th>D (Degree)</th>
<th>H (Height)</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Shift</code> + Mouse Wheel</td>
<td>Bow Curve</td>
<td>10°</td>
<td>.1 unit</td>
</tr>
<tr>
<td><code>Shift</code> + + or -</td>
<td>Bow Curve</td>
<td>10°</td>
<td>.1 unit</td>
</tr>
<tr>
<td><code>Ctrl</code> <code>Shift</code> + Mouse Wheel</td>
<td>Bow Curve</td>
<td>1°</td>
<td>N/A</td>
</tr>
<tr>
<td><code>Ctrl</code> <code>Shift</code> + + or -</td>
<td>Bow Curve</td>
<td>1°</td>
<td>.1 unit</td>
</tr>
</tbody>
</table>

The curve for our sketch is a rounded corner (90°) whose first point is already establish at the end of the 17’ line (A) in the illustration below. We’ve also measured our second point to be 10 feet up from the end point of the 27’ line (B).

Using Reference Points

**Note:** Many users find using reference points to be handy by making note of where the curve begins and ends. This helps you place the Chord easily and from there apply essential measurements of Arc Height, Arc Angle or Arc Length.
To draw this curve in Apex, do the following:

1. Press `1` `0` `↓` 10 feet down. **Don't press ENTER**

2. Press `CTRL` `→` **Align Right**. **Don't press ENTER**

3. Press `ENTER` 6 times. **Until Degree of Curvature is 90°**

Your screen should look similar to the following:

![Curve Drawn](image)

**Enter** **Press ENTER to anchor the curve.**

**Note:** The curve could have also been positioned after changing the degree or arc height as well. Additionally, using what you've already learned, you could have bowed the curve with your mouse, placed it near the end point of the 17° line (B) and pressed `J` to jump to the point, then `1` `0` `5` to position your curve properly.
Keyboard & Mouse Drawing Method (continued)

Let's continue with our sketch by completing this area as well as add the final area of our sketch.

10 feet down, Anchor the line (ENTER)

25.5 feet right, Anchor the line (ENTER)

28.5 feet down, Anchor the line (ENTER)

25.5 feet left, Anchor the line (ENTER)

Press ENTER to pick the pen up.

Your screen should look similar to the following:

All Areas Drawn (Not Defined)

Now that you've completed drawing your sketch with Keyboard & Mouse, all you need to do now is define the areas you've just drawn. You can skip ahead to Chapter 4 – Area Definition to learn more about this topic.
Active Pen Drawing Method

Drawing with an Active Pen in Apex Sketch v6 is about as close to drawing with pencil and paper you can get. In fact, when you learn how to draw your lines directly on your Windows Tablet, you might even say it’s better than pencil and paper. We’d agree! The following section is designed to take you through the same sketch you drew with Keyboard & Mouse, but from an inking perspective.

Active vs. Passive Pen

When using an Active Pen you can hover over the screen and see a cursor appear and move. Passive Pens will only work when physically touching the screen. This is what most people refer to as touch or capacitive. A common problem with capacitive screens occurs when attempting to write and resting your palm on the screen itself, resulting in focus issues. Newer devices that support both active and capacitive functionality are much better at preventing this and Apex Sketch v6 takes full advantage of touch and ink.

Ink vs. Touch

The primary difference between these two modes is the paradigm in which you interact with Apex Sketch v6. Active Pen Drawing utilizes “inking” features of the tablet along with character recognition where Touch Drawing Method provides a touch panel where you can tap in distance & direction as well as access other common drawing functions with a touch of your finger. We’ll revisit Touch in the next section. For now, we’ll focus on ink.

Drawing Modes

As with Keyboard & Mouse, you must first be in a drawing mode before you can begin drawing. When you launch Apex Sketch v6 this is the default mode the program is set to so you can being drawing immediately. To activate a drawing mode, simply tap on Draw Exterior or Draw Interior located in the toolbar on the left side of the user interface.

**Draw Exterior:** This Drawing mode allows you to draw lines (typically exterior) which will be used for calculation purposes. Simply put, if you want/need to calculate the shapes you draw – this is the tool you should use.

**Draw Interior:** This Drawing mode allows you to draw lines (typically interior) which will be used for illustration (non-calculation) purposes. This line style is generally used to depict interior floor plans, fence lines, property lots, streets, etc.

Now that you have a Drawing Mode selected, as you hover over the drawing port you will notice your cursor change to a crosshair indicating you are in a drawing state. Unlike Keyboard & Mouse however, there is no Pen Up or Pen Down as your pen touching the screen or not literally determines the drawing behavior.

Area Definition

As mentioned with Keyboard & Mouse, Area Definition takes place after drawing. This is more helpful in the field as there are many times when it’s difficult to know what you’re actually measuring/drawing until you’ve traversed more of (or are inside) the property.
Active Pen Drawing Method (continued)

Choosing a Starting Point
Although you may need to decide the best location to begin measuring your property, the unique drawing nature of Apex Sketch allows you to begin drawing practically anywhere within the drawing port. You can use the Center or Center & Fit buttons to keep your sketch in view at all times.

Note: See Canvas/View Tools (Page 36) to learn more about Center and Center & Scale.

Drawing a Line with Ink
Once you’re in Draw Exterior or Draw Interior, simple draw a line as you would with pencil and paper directly within the drawing port displayed on your Tablet PC.

Common Misperception 1 – Counting Squares
Many users find it difficult to break age-old habits and when it comes to drawing on graph paper is the perfect example. The grid you see (default) is purely to help you with your transition and aid you with visual alignment. However, you no longer need to count squares when drawing your floor plans. We’ve coined a new term with Apex Sketch called “guess”turing where you simply “flick” a line in a given direction and then specify its length by writing directly over the rendered dimension. We want to improve how quickly you create floor plans in the field. Removing the need to count squares is only the beginning.
Active Pen Drawing Method (continued)

Pen Away Events
To aid in the speed of drawing, Apex Sketch does not rely on timers that require you to pause and wait as a trigger for the application to render lines. Instead, Apex takes advantage of pen away events that allow you to control when the application should perform this function. A Pen Away event requires that you lift your pen away from the screen approximately 3” to 6” (inches). When doing so, Apex will then render the line and dimension.

Note: If you notice that nothing is changing when drawing lines or changing dimensions (i.e. ink lines or handwriting still remains in your display), Apex Sketch may be waiting for the Pen Away event to occur.

Rendered Line and Dimension
Once you get the hang of drawing lines using your Active Pen, you’ll find that you can draw rather quickly using this technique and that it’s not all that different from pencil and paper. Once you lift your pen away the line and dimension will be displayed to look similar to the following:
Active Pen Drawing Method (continued)

Inking yet no Lines
There may be times when you ink in a line and it doesn’t appear. Beyond the obvious check to ensure you’re in a draw mode, the most common reason for lines not rendering may be how you’re drawing them. Sometimes when we drawing lines, we might inadvertently add a “tail”; typically when attempting to count square or be overly precise.

When this occurs, Apex Sketch may confuse this with a gesture and/or not recognize what you’re attempting to do. To avoid this, we recommend the following technique when drawing lines.

Although this illustration (above) is a bit exaggerated, this technique will greatly enhance your ability to draw lines in Apex. With a little practice you’ll learn that drawing lines is essentially a “flick” in the direction you wish to go which naturally causes the Pen Away events we covered earlier.
Active Pen Drawing Method (continued)

Changing a Dimension – Hit Boundary

In the same manner you would draw lines and annotate your sketch with pencil & paper, Apex allows you to draw lines and input dimensions. Now that you've drawn the first wall, unless you are extremely accurate with your flicks – most of the lines you draw will require you to edit the dimensions. To do this properly, you must first learn a critical element of drawing with an Active Pen in Apex Sketch. Let's take a look at the 28' line we drew up close:

The above illustration displays what we refer to as the Hit Boundary which appears when hovering over the dimension with an Active Pen. In order to change this dimension, it is essential that your pen touch down somewhere within the highlighted region for ink recognition to take place. A good rule of thumb is to make sure the Hit Boundary is highlighted (as above) as you touch your pen down on the screen of your device.

Dimension Text Input Panel (DTIP)

Provided you placed your pen down on the dimension, the input panel will display as shown below.

This panel will appear once you have touched the dimension with your pen.

**Note:** Had you not properly touched down within the Hit Boundary, this panel would not have appeared.

Tapping this button will clear any input you currently have written (inked).

Tapping this button will accept the input you have currently inked in on the panel.

This area is actually meant more as a “hint” that you’re supposed to write something. You soon learn that you can write beyond these boundaries if you wish to do so.
Active Pen Drawing Method (continued)

Input Panel vs. Pen Away
In order to use the input panel properly it is important that you do not pull your pen away from the device. This panel was added as an additional method to assist you with “hints”, but also provide the means to quickly clear and/or your changes by tapping on the corresponding button.

If you’ve become accustomed to Pen Away events, you do not need to worry about tapping clear or accept as when you are finished making your edit, simply pull your pen away from the screen (as discussed earlier in this chapter) and the dimension will adjust accordingly.

As you follow along in this example, feel free to use whichever method is most comfortable with you. Accepting the changes when making edits for each step in the example(s) will be assumed.

Practice Makes Perfect
It is recommended that you practice drawing single lines and changing dimensions for a bit. Once you get the hang of it, you’ll find changing dimensions to be a very simple process.

Note: As you practice, you will notice the results may vary depending on whether you “hit” the dimension, ranging from additional lines drawn to “nothing” appearing to happen.

Common Misconception 2 – Writing Small
Old habits are hard to break and writing small (to reduce clutter) is one of them. When it comes to inking, there are times writing small (even legibly) can actually cause problems with character recognition than writing in a size and/or fashion that’s comfortable to you. Because Apex Sketch will automatically resize the dimensions it renders to the default(s) specified in settings, you’re free to write (recommended) as large as you like. Just remember, it’s critical that you always place your pen down in the “hit boundary” to do this successfully.

As we mentioned earlier, the input panel boundary is simply a “hint” to imply where you should write. As you can see in the example above, you can write outside of the boundary as well. With Apex Sketch, you don’t need to worry about the constraints paper and pencil impose!
Active Pen Drawing Method (continued)

Draw the First Line
Now that you have the basics for drawing single lines down, let’s draw the first line of our sketch and edit it to be 30’ long. Be sure you’re in Draw Exterior mode!

To begin sketching simply “Ink” a horizontal line as illustrated here.

Apex Sketch v6 is waiting for a “Pen Away” event. Pull your pen away from the screen and the line will render.

Hover over the dimension to display the Hit Boundary. Place your pen down anywhere within the highlighted area.

Change the 33.0’ dimension to 30’ by writing over the input panel as shown here.

Tap on accept or pull your pen away from the screen and the line will adjust as you see here.

Note: The input panel in the above example may be disabled under Tools > Options > General (Tab). This is advised only if you find the input panel distracting or wish to work solely with pen away events. Otherwise, we recommend leaving the input panel enabled for the added convenience it offers.
Active Pen Drawing Method (continued)

The Big Red Dot

Now we’re ready to draw the next line in our area, but before doing so – we need to cover another important topic. Because of the new drawing paradigm offered in Apex Sketch v6 that allows you to draw where you want; when you want along with the new area detection algorithms, we needed to provide the means to ensure areas are truly closed. To do this, we introduced the “Big Red Dot” that not only shows alignment, but also indicates that the next line you draw will be “connected” to the point you’re hovering over. Let’s continue our sketch by performing the following to illustrate how this works.

In order to draw a connected (attached) line, move your pen over (hover) the endpoint you wish to draw from and the “Big Red Dot” will appear as illustrated here.

As long as the Big Red Dot is displayed when you place your pen down to draw, Apex Sketch will connect the next line you draw to the point from which you drew.

**Note:** Even if your pen is slightly off, as long as the Big Red Dot was displayed, it will connect the lines.

Once you pull your pen away the line will be rendered (and connected) accordingly.

Other Indicators for Connected Lines

There are a couple of visual indicators that also indicate lines are connected properly.

- The angle indicator (in this case 90°) is displayed. Had the 17’ line not been connected to the 30’ line (above), the angle would not have been displayed.

- When a segment of a polyline (series of connected segments) is selected, all lines attached to that segment will highlight in green (as illustrated above). Had the 17’ line not been connected to the 30’ line (above), the 30’ line would not have changed colors and would have remained “Navy”. 

Common Misconception 3 – Edit Dimension Orientation

Now that the second line of the area is drawn, the automatic orientation of the dimension brings up another important concept to cover. As you may have noticed with the line drawn in the previous example, the dimension automatically rotated. While using a tablet in the field, the natural tendency is to rotate the tablet so you can properly edit the dimension in much the same manner as drawing with pencil and paper.

Writing Vertically will not be Recognized

Always Write Horizontal to Tablet Orientation

When editing dimensions in Apex Sketch, you shouldn’t change the orientation or write in the same direction as the dimension itself (as illustrated above). Doing so will likely result in failure to recognize your writing or in inadvertently draw additional lines.

Always write or change dimensions in a horizontal fashion (as illustrated above). This ensures Microsoft ink recognition. Remember, you don’t need to write small.

Change the dimension to 20’ as illustrated above. Your screen should look similar to the following:
Active Pen Drawing Method (continued)

Now that we’ve covered most of the essentials let’s draw a few more lines in our first Area.

Hover over the open end of the 20’ line. The Big Red Dot should appear. Once it does, ink a line to the right. Remember, you don’t need to worry about the length yet.

The line will render as shown here.

Hover over the dimension to display the Hit Boundary.

Place your pen down to display the input panel. While your pen is still down, change the dimension to 27’ as illustrated.

Tap the accept (check) or pull your pen away from the screen. The dimension will update to reflect the new dimension.

Note: The example above shows each state of the line as you would draw it. Moving forward, the hover for the Big Red Dot and Hit Boundary will be assumed.
Hover over the open end of the 20’ line. The Big Red Dot should appear. Once it does, place your pen down and draw (ink) a line to the right. Remember, you don’t need to worry about the length.

The line will render as shown here.

Hover over the dimension to display the Hit Boundary.

Place your pen down to display the input panel. While your pen is still down, change the dimension to 27’ as illustrated.

**Centering your Sketch**

You’ve already learned that you can press “C” or “SHIFT C” to Center or Center/Fit your sketch from a keyboard perspective. However, while mobile – using a keyboard and/or mouse isn’t always feasible and certainly counterproductive. Located in the lower left portion of the interface are the Canvas Tools discussed in Chapter 2. These tools are designed to assist mobile users with maintaining the view of the sketch.
Active Pen Drawing Method (continued)

Center: This function will center the sketch in the Drawing Port. This is convenient while drawing as it allows you to quickly adjust your sketch whenever you draw off of the drawing port keeping it in view.

Center & Fit: Although the Center function is valuable, sometimes, centering your sketch isn’t enough as your sketch may be too large (or too small) in its current size. This function will Center and Fit the sketch (by its extents) in the drawing port bringing the entire sketch into view.

To continue with our example, we need to **Center** the sketch. To perform this function, tap the Center button as highlighted below.

![Center Sketch Function (Before)](image1)

After pressing Center, your sketch will adjust bringing all the lines you have drawn to this point into view.

![Center Sketch Function (After)](image2)
Let's continue with our sketch by performing the following.

Draw a line to the left as illustrated here.

Once the line renders, change the dimension (if necessary) to be 10’ in length. Accept the changes by tapping the Accept (check) button or pull your pen away.

Draw an angled line down and to the left in the same manner as the previous lines you’ve drawn.

All lines drawn at an angle will automatically render to 45° (deflection) 135° (interior). We’ll adjust this line’s length in a moment, but first – a little more about angled lines...
Angled Lines with the Active Pen

Drawing angled lines with an Active Pen in Apex Sketch is a simple intuitive approach that allows you to edit every element of your wall based on the measurements available to you in the field.

Rise & Run is the most common way you would measure and draw short, angled walls such as a bay window. The illustration to the left highlights the elements you would need to edit.

Deflection Angle (Red) and Interior Angle (Blue) allow you to specify the angle the wall turns in relation to the direction you are drawing. Deflection is the most common angle measured and/or modified.

The first area we are drawing contains a Bay Window. The Rise & Run measurements for this example are 5’ x 5’. Let’s draw this now by performing the following:

Picking up where we left off with the angled line selected, hover over the Rise dimension as illustrated to the right.

Place your pen down and write (ink) the Rise dimension of 5’. Keep in mind, this is no different than editing any other dimension to this point.
Tap the Accept (check) button or pull your pen away and the change will take effect.

**Note:** Rise & Run will dictate the actual length of the wall. If your Rise & Run measurements/inputs are accurate, the wall’s length and orientation will be as well.

Now hover over the Run dimension as illustrated to the right.

Place your pen down and write (ink) the Run dimension of 5’ just as you did with the Rise dimension.

Tap the Accept (check) button or pull your pen away and the change will take effect. Your angled wall is now complete!
Let's continue with drawing the bay window by performing the following:

Tap the Accept (check) button or pull your pen away and the change will take effect.

**Note:** Rise & Run will dictate the actual length of the wall. If your Rise & Run measurements/inputs are accurate, the wall's length and orientation will be as well.

Now hover over the Run dimension as illustrated to the right.

**Alignment Points “Dots”**
As you draw lines, you've undoubtedly noticed several to many “dots” appear in your drawing. You may have also noticed that these appear when you have a line selected (as illustrated below) in Draw Mode. These dots are actually alignment indicators designed to speed up the drawing process by allowing you to draw in a dot-to-dot fashion wherever possible. Tapping on any of these dots will automatically draw a line from the selected line to the specified alignment point.

**Red Alignment Points** indicate Vertical and Horizontal alignment with other points in your sketch.

**Blue Alignment Points** are primarily intended for completing Bay Windows but can be used to complete other more complex shapes such as Gazebos.

Hovering over any of the alignment points will display reference lines making it easy to see which points/lines the specified alignment point is aligned with.
Understanding how these alignment points function will come in handy. Let continue with our example.

Hover over the Blue Alignment Point as illustrated to the right. The Reference Line will appear indicating which point/line it is aligned with.

Tap the Blur Alignment Point and Apex Sketch will automatically draw a new wall which mirrors the opposite side of the Bay Window. The Bay Windows is now complete.

Continuing with the first Area, draw a new line to the left as illustrated here.

Change its dimension to 10’.
To prepare for our next topic, perform the following:

From the open end of the 10’ foot line, draw an angled line up and to the left as illustrated here.

Hover over the Rise dimension as highlighted to the right.

Place your pen down and change the dimension to 12’.

Tap the Accept (check) button or pull your pen away and the line will adjust to reflect your change.
Active Pen Drawing Method (continued)

Direct Angle Input

If you’ve used Apex product for some time, you know Rise & Run input is a great way to determine the orientation (angle) and length of the walls you measure. However, as was mentioned in the previous section (Keyboard & Mouse), gathering Rise & Run measurements for long walls can be difficult even in the most ideal situations. If you have a tool such as a Mite -R- Gage®, Apex Sketch allows you to input the angles you measure as well.

**Note:** If you would like to learn more about tools (i.e. Mite -R- Gage®) that help you determine angles without Rise & Run, see page 58.

The “Turn” feature is very helpful with Keyboard & Mouse which requires you to gather the Length of the wall, the direction it turns and the degree of change (deflection angle) based on the direction you are drawing. Although much of this information is still necessary when drawing in the field, Active Pen input allows you to directly write (ink) over the angle measurements to reflect what you’ve measured.

In our example, the next wall we need to draw is a 45° angle. Because we automatically default to 45°, there would little change for you to do accept change the length of the line (if necessary). Hence, the previous steps were to prepare us for Direct Angle Input.

The next wall is 17’ long at a 45° angle. Let’s continue with the first Area by editing the appropriate elements of the line to match our measurements.

To change the angle of a line, hover over the deflection angle (red) as shown to the right.

**Note:** You can also change the Interior Angle (blue) if you’ve gathered that data instead. Deflection is more common and is typically reserved for angles ranging from 1° to 90°.

Place your pen down and change (ink) the angle to 45° as illustrated here.
Active Pen Drawing Method (continued)

Tap the Accept (check) button or pull your pen away from the screen and the line will adjust to reflect the change.

Now let’s change the length of the line. Hover over the dimension as shown here.

Place your pen down and change the dimension to 17’.

Tap the Accept (check) button or pull your pen away and the line will adjust to reflect your change.
Let's complete our first area by performing the following:

Hover over the Red Alignment point to the left of the 17' line as illustrated to the right. This point is in alignment with the POB (Point of Beginning).

Tap the Alignment Point, and the line will be drawn.

Hover over the POB (Point of Beginning) as shown here.

Tap the POB and the line will be drawn. The area is no longer highlighted designating that it has been completed.
Active Pen Drawing Method (continued)

Importance of Using Alignment Points
Using alignment is important when squaring your areas. Although you could have input 4.0 to the left, using alignment here (especially off of an angle as illustrated), this ensures that your sketch aligns perfectly (mathematically). It’s likely that the 4.0 dimension is rounded in accordance with your decimal precision and NOT actually 4.00 mathematically. In this case, the same will also be true with the closing dimension. Don’t worry though, Apex Sketch uses the actual geometry to derive its calculations (not the rounded/displayed dimensions) giving you extremely accurate results. If you would like to see a more precise dimensions displayed we recommend changing the decimal precision (decimal places) under Tools>Options>General (Tab).

Your screen should look similar to the following:

Congratulations! You’ve drawn your first area in Apex Sketch v6 using an Active Pen! It hasn’t been defined or calculated just yet, but you’ll do that in the next chapter (Area Definition).

Drawing Attached (multiple) Areas
For the purpose of learning how to draw with an Active Pen, the first area was created without any consideration of attached areas. When drawing multiple areas, you do not need to complete the current area to begin drawing a new one as you would with previous versions. Apex Sketch v6 was built from the ground up to match your workflow; especially while in the field.

You’re now free to draw any lines and areas in any order you wish which was the main impetus behind our change to the Define Area process. Simply draw shapes as you encounter them and define them later. After you’ve learned the following topics, we recommend that you practice by redrawing the same sketch in a manner that suits your specific workflow and preferences.
Active Pen Drawing Method (continued)

Auto-Jump "Snap"
When you hover around your sketch with your pen, you may notice your drawing cursor snapping to points of alignment and other end points. In the absence of a keyboard to press J (Jump), Apex Sketch v6 is set to automatically snap to these points so you can reliably draw off of other endpoints and areas.

We need to draw “attached” areas to the first area we’ve completed. The following exercises will show you how this is done as well as introduce you to drawing curves.

While in Draw Mode, hover over the endpoint where the 30’ and 20’ lines connect. As you move near the point, you may notice it snap to alignment and display (as before) the Big Red Dot ensuring any line you draw will be connected to these lines.

Place your pen down and draw a line to the right.

Change the dimension to 17’.

Once you’ve accepted the changes, the first line in your new area should appear as illustrated to the right.
Active Pen Drawing Method (continued)

Drawing Curves with an Active Pen
As mentioned in the previous section, measuring curves tend to present the biggest challenge in the field. However, if you can measure it, you can draw it. By now, you’ve likely noticed that drawing in Apex Sketch v6 with a pen is driven by visual cues. For example, when drawing an angle to the left (in the direction you are drawing) is done by drawing it just as you “see” it. When it comes to curves, the approach is no different. But before we do this, we need to cover the topic of reference points.

Although you could just draw a curve directly off of the last line we’ve drawn, the recommended method for drawing curves involves the use of reference points from which we’ll establish the chord of the curve.

In the illustration to the left, highlights points that could have been referenced (recommended) to establish the chord of the curve. In this example, we know that the curve begins 17’ to the right of the 20’ line (A) and 10’ up from the 27’ line (B).

With this in mind, the 17’ and 10’ line should be drawn before drawing the curve itself.

We’ve already drawn the 17’ line to this point. Let’s draw the 10’ line by performing the following:

While in Draw Mode, hover over the endpoint where the 27’ and 28.5’ lines connect. Draw a line up (as illustrated to the right) and apply what you’ve learned to this point by changing the dimension to 10’.

Once you’ve changed the dimension you’ve successfully established your reference points for the curve we need to add.
We’re ready to add the curve to complete this area. Let’s do this by performing the following:

Hover over the endpoint of the 17’ line. Once you have the Big Red Dot, draw a big curve as illustrated to the right until you reach the endpoint of the 10’ line.

*Note:* You may draw a shallow curve if you wish. This was done for this example to illustrate an obvious curve.

When the curve is rendered, you will be presented with all the elements that you can edit based on the available data you’re able to gather on site.

1. **Arc Height**  
2. **Arc Angle**  
3. **Arc Length**  
4. **Chord Length**  
5. **Rise & Run (Chord)**  
6. **Radius**

Most corners (like this one) are just rounded corners. If that’s the case, we can easily change the Arc Angle to 90° by hovering over its dimension as shown here.

Place the pen down and change the Arc Angle to 90°.
Active Pen Drawing Method (continued)

Tap the Accept (check) button or pull your pen away and the curve will adjust to reflect your changes.

That’s all there is to it! Your Screen should look similar to the following:

Second Area with Curve Drawn

Note: The previous example is just one of several ways you could construct curves in Apex Sketch v6. You’re not restricted to having to create Reference Points. For instance, if you know the Rise & Run of the Chord, simply edit those dimensions to match your measurements and the chord’s length and bearing will be established.

Where’s Auto-Trace?
Apex Sketch v6 no longer requires that you trace common walls back to the POB bringing you once step closer to a Pencil and Paper style of drawing. As you may have noticed in the previous area we drew, we did not draw additional lines to “close” the shape. We enhanced Area Detection algorithms that allow us to draw only the lines we need to complete areas. Say “Goodbye” to Auto-Trace.
Let's continue and draw the last area of our sketch by performing the following:

While in Draw Mode, hover over the endpoint where the 10’ and 28.5’ lines connect (lower right). As you move near the point, you may notice it snap to alignment and display (as before) the Big Red Dot ensuring any line you draw will be connected to these lines.

Apply what you know to this point and draw a 25.5’ line to the right.

In a dot-to-dot fashion tap on the Alignment Point (as illustrated here) to automatically draw a 28.5’ line up.

Tap the alignment point to the left (the intersection of the 27’ and 28.5’ lines) to complete the last area of your sketch.
Active Pen Drawing Method (continued)

If you’ve been following along, congratulations! You’ve completed your first sketch using the Active Pen method. Your screen should look similar to the following:

Now that you’ve completed drawing your sketch with the Active Pen, all you need to do now is define the areas you’ve just drawn. You can skip ahead to Chapter 4 – Area Definition to learn more about this topic.
Touch Drawing Method

This section is designed for those users who have Windows Touch Tablets or Active Pen users who prefer the Touch Method of drawing. We’ll take you through the same sketch we’ve drawn in the previous sections but this time from a touch only point of view. If you’ve used any of our MobileSketch products on Pocket PCs, iPad or Android, then this will likely feel familiar to you.

Accessing the Touch Panel

In order to draw using the Touch Panel you must first enable touch from Tools>Options>System Tab.

To enable the Touch Panel, simply check the “Touch Screen” option as illustrated to the left. Press the OK button to accept your changes.

Note: Enabling the touch panel will require you to restart the application.

Once you’ve restarted Apex Sketch, the Touch option will be available on the left toolbar as illustrated below.
Define Area Process
Just as we've covered in previous sections, you no longer need to define the area before drawing. Whether you're drawing from a set of plans and hand drawings or drawing on site, the process is the same. We'll cover Area Definition in Chapter 4.

Drawing Modes
Before you can begin drawing you must first be in a drawing mode. When you launch Apex Sketch v6 this is the default mode the program is set to so you can begin drawing immediately. To activate a drawing mode, simply tap on Draw Exterior or Draw Interior located in the toolbar on the left side of the user interface.

Draw Area (Exterior): This Drawing mode allows you to draw lines (typically exterior) which will be used for calculation purposes. Simply put, if you want/need to calculate the shapes you draw – this is the tool you should use.

Draw Interior: This Drawing mode allows you to draw lines (typically interior) which will be used for illustration (non-calculation) purposes. This line style is generally used to depict interior floor plans, fence lines, property lots, streets, etc.

Now that you have a Drawing Mode selected, your cursor will change to a Crosshair which will change in appearance depending upon its state.

Cursor States
Part of our improvement to provide a “Draw First” paradigm is the added ability to draw wherever you wish, whenever you wish. This freestyle approach however requires some visual cues that indicate whether the pen is “Up” or “Down”.

Pen Up: The basic rule of thumb about Pen Up is when it is in the state, lines will not be drawn. This allows you to move your cursor wherever you wish. This is helpful when encountering difficult areas of your property and need to come back or tackle this problem from a different angle. It's also useful when needing to draw other areas as you come to them whereas in previous versions you had to complete the current area prior to doing so.

Pen Down: Pressing or tapping the sketchpad while in Pen Up state will cause the cursor to highlight/fill in green indicating that any cursor movement from this point will draw a line. The same is true regardless of the Drawing Mode (Area or Interior). To pick the pen up again, all you need to do (with no line drawn) is press or tap the sketchpad once again.

Note: Pen Up and Pen Down can be performed only while in a Drawing Mode. Continuing to press will pick the Pen Up or place the Pen Down (with no line drawn) in the same fashion as Free Form lines in previous versions.
Drawing with Touch
Apex Sketch v6 allows you to draw in several fashions including your finger and the touch panel which you can mix and match their uses based on your own style of drawing. The following is a brief description of each of the drawing inputs you can use to create your floor plans.

**Finger Drawing**
Apex Sketch allows you to draw with your finger by simply placing your finger on the sketch pad and move the cursor in the direction you wish to draw a line.

**Drawing with Directional Pad**
You can draw with your directional pad by pressing the direction you wish to draw. With each tap of an arrow key, your drawing cursor will move 1 unit in the specified direction. Activating the Shift toggle will draw in “tenths”.

**Note:** By default the Ctrl toggle is active (on) for added convenience to align with other points. To draw in 1 unit increments, Ctrl must be turned off. Otherwise, pressing the arrows in the directional pad will either not move the cursor, or “pop” it into alignment with another endpoint in the direction pressed.

**Drawing with Distance & Direction with Touch Panel**
Distance and direction is probably the most popular way users draw in Apex products today and is arguably quicker than most of the other methods. To do this, simply enter a distance on the number pad and then specify a direction with your directional pad. The cursor will travel the distance input and the line will be drawn.

**Note:** All of the above descriptions assume the cursor is in a “Pen Down” (green cursor) state. Otherwise, the cursor will move as described, but no line will be drawn.

**Drawing Your First Shape**
We’ll add more functions and capabilities as we move through the rest of this chapter. For now, we’ll focus on the steps necessary to draw your first line and shape. As discussed, there are several ways to draw with touch, but we’ll focus on the method most commonly used – distance and direction.

Make sure you are in Draw Exterior Mode by tapping it on the toolbar to the left.

Press **ENTER** or click your left mouse button to place the Pen Down.
Your screen should look similar to the following:

**Note:** Unlike when drawing with pencil & paper, you don’t need to worry with where to begin. In Apex Sketch, simply choose a place to begin and begin drawing. You’ll learn more how to manage your sketch later in this chapter.

The first line in our sketch is **30 feet to the right**. To draw this, input the following:

**Note:** Pressing **ENTER** anchored the line which will also automatically anchor the dimension (by default). If you wish to manually place dimensions you may do so through **Tools>Options>General Tab>Auto Placement**.
If you’re accustom to pressing \( \text{ENTER} \) twice to anchor the line and dimension in previous versions, doing so will pick the pen up when you may not have intended to. If this happens, press \( \text{ENTER} \) again to put the pen down again. Let’s continue with the next line, which is **20 feet down**.

At this point your sketch should look similar to the following:
Now that you have the hang of drawing straight lines, let’s draw a few more by inputting following measurements and directions:

- 27 feet to the right, Anchor the line (ENTER)
- 28.5 feet down, Anchor the line (ENTER)
- 10 feet to the left, Anchor the line (ENTER)

**Note:** Depending on your resolution, your cursor may have moved off of the drawing port causing the drawing port to Auto-Pan to follow the drawing cursor. We’ll discuss this next.

After drawing the previous lines (depending on your resolution), your screen may look similar to the following:

![Auto-Pan Functionality](image)

When we drew our sketch at this resolution and input the 28.5 foot line down, the drawing port changed to display what you see in the illustration above.

Had you been drawing with pencil & paper, you’d be faced with the decision to redraw your sketch, flip to the back side or tape on an additional sheer of paper to continue! Apex Sketch is designed to reduce this frustration by providing a canvas that accommodates anything you draw.
Auto-Pan
Apex Sketch v6 will automatically pan the drawing port whenever you draw outside of its boundaries. This is done to always keep your drawing cursor in view. This is helpful when drawing large properties where viewing the entire sketch at once would make it too small to see its dimensions.

Center Sketch and Center & Fit
If you wish to bring your sketch into view, press and your drawing port will adjust and display your sketch centered within its boundaries. However, there may be times when centering where the sketch is still too large for the drawing port. Pressing will Center & Fit the sketch on the canvas.

Note: You can use the Center command at any time keeping your sketch centered within the drawing port.

We'll center our sketch now by pressing and if you’re following along, your screen should look similar to the following:
Helpful Hint
During the course of drawing areas you may notice the "poly" (attached lines) you are currently working with is highlighting in fuchsia (pink). You may also notice the POB (Point of Beginning) is also designated by a pink circle endpoint. This is done by design to give you visual cues of the active shape you are constructing.

Pink is Good
When the entire polyline you are working on is green, it indicates that you have no “breaks” in your shape. This is an important concept as when there are breaks your shape may not define properly. Had the poly in the example above had breaks (gaps) you might see a relocation of the POB or the poly itself would not be green throughout.

Note: When the entire shape is not pink, it’s not always a sign of a problem. For instance, when drawing an enclosed shape that is attached to another area, ONLY the lines necessary to close the shape may be pink. This will become clearer as we continue with this example.

Drawing a Bay Window – Introduction to Rise & Run
Apex Sketch v6 allows you to draw angles using Rise & Run measurements. In our example the Rise & Run measurement is 5 feet by 5 feet (5’x5’). You can easily construct this in Apex by drawing the following:

DON’T PRESS ENTER (YET)

ENTER

Pressing ENTER will accept your changes.
Stacking Dimensions

Rise & Run is an example of Stacking Dimensions by which you manipulate a line's length and orientation by inputting multiple measurements and distances to create angled walls and adjusted lengths. At this point, your screen should look similar to the following:

Let’s continue with our sketch by completing the rest of the bay window. Do this by inputting the following measurements and directions:

- **11 feet to the left**, Anchor the line (ENTER)
- **5 feet left**, Don’t press ENTER
- **5 feet up**, Anchor the line (ENTER)
- **10 feet left**, Anchor the line (ENTER)

**Note:** You’re not required to enter Rise or Run in a specific order. Just as the above angle was drawn by inputting 5 feet left and 5 feet down, the same angle could have been made by inputting 5 feet up and 5 feet left.
Your screen should look similar to the following:

**Direct Angle Input – “Turn”**

Small angles are fairly easy to measure and draw. However, there are times when you may encounter angled walls where obtaining the Rise & Run measurements can be quite a challenge.

The wall we would like to draw measures **17’ in length** and **angles to the right at 45°**.

**Note:** “Turn” refers to the swing of the wall in relation to the overall direction you are drawing. Imagine walking along the path of the previous walls drawn. Which way would you need to “turn” to maintain the same path for the angled wall?
As was mentioned on the previous page, the wall we would like to draw is **17 feet** long and turns to the **right** at **45°**. To draw this line in Apex Sketch, you would input the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 7</td>
<td>17 feet, <strong>Don’t press ENTER</strong></td>
</tr>
<tr>
<td>R</td>
<td>Turns to the Right, <strong>Don’t press ENTER</strong></td>
</tr>
<tr>
<td>4 5</td>
<td><strong>45° angle</strong></td>
</tr>
</tbody>
</table>

Look at the input display at the top of the touch panel. As you entered the above commands, this updates to reflect your input.

- Press **ENTER** to accept the input and draw the wall.
- Press **ENTER** once again to anchor the wall.

**Note:** When using the turn feature, the input display will default to **90°** immediately after specifying a direction (Right or Left). To change this to something other than **90°**, simply input the angle and it will overwrite the default. This is done by design to allow you to quickly accept the **90°** angle (most common) without having to input it.

Your screen should look similar to the following:
How do I determine the angle of the wall without Rise & Run?

There are several tools available on the market today to help you measure angles. We recommend using the Mite -R- Gage® as it’s made of durable material (Lexan) and has extended arms that aid in the accuracy of your measurements.

Contact us (800.858.9958) if you’re interested in learning more about this measuring device.

Alignment

There are several alignment tools that ensure your areas are attached and/or “squaring” properly. As with previous versions, Apex Sketch v6 has various forms of alignment and snapping features at your disposal. The following are the alignment functions of Apex Sketch when using in a Touch fashion.

**Finger Movement**

**Auto-Alignment:** While moving your cursor, you may notice that it automatically snaps to endpoints of lines and when it comes in alignment with other points.

**Jump:** Located in the center of the directional pad, Jump will move the cursor to the nearest endpoint. It is recommended that you use this function for attached areas and/or continuing with partial areas to ensure the lines are truly attached versus the appearance that they are.

**Align:** Ctrl is a modifier key used to snap to alignment when used in conjunction with arrows. When activating Ctrl and pressing an arrow, the drawing cursor will travel to the next point of alignment in the specified direction.

**Intersect:** Ctrl, Shift and an arrow will move the cursor in the direction specified until it intersects with another line, bypassing all other alignment points that may exist along the way.

*Note:* Becoming proficient with your alignment tools will save you a lot of time when creating your floor plan sketches. We recommend practicing with these tools until you get a good feel for how they work and the best situations you should use them.
Alignment Styles
You can adjust the appearance of alignment in Apex Sketch through Tools>Options>Display Tab. You can turn them on or off, change the style from Dashed to Solid and also adjust the color if the default is not suitable for your preferences.

Let's make use of our first alignment function to bring the drawing cursor in alignment with the (POB) Point of Beginning. As we covered earlier in this section, the Ctrl modifier key is on by default for added convenience.

When alignment is on, the Ctrl modifier will appear as grey.

When alignment is on, the Ctrl modifier will appear as orange.

Understanding this, make sure your alignment modifier is on and perform the following.

Align Left
Press ENTER to anchor the line.

Your sketch should look similar to the following:
Importance of Using Alignment Tools
Using alignment is important when squaring your areas. Although you could have input 4.0 to the left, using alignment here (especially off of an angle as illustrated), this ensures that your sketch aligns perfectly (mathematically). It’s likely that the 4.0 dimension is rounded in accordance with your decimal precision and NOT actually 4.00 mathematically. In this case, the same will also be true with the closing dimension. Don’t worry though, Apex Sketch uses the actual geometry to derive its calculations (not the rounded/displayed dimensions) giving you extremely accurate results. If you would like to see a more precise dimensions displayed we recommend changing the decimal precision (decimal places) under **Tools>Options>General** (Tab).

Completing Areas with Auto-Close
Auto-Close is an important feature that allows you to close the areas you draw. However, due to the new drawing engine of Apex Sketch, you may find that you don't use it as much as you used to.

Let’s close the area we’ve been working on by pressing (as illustrated below).

![Auto Close](image)

Congratulations! You’ve drawn your first area in Apex Sketch v6 using touch! It hasn’t been defined or calculated just yet, but you’ll do that in the next chapter (Area Definition). For now, let’s continue to create the lines in our sketch that make up the other areas of the property.

**Note:** When you auto-close an area, the color changes from pink to the default line color. The pen changes from green to grey indicating “Pen Up” allowing you to move your cursor to another location.
Drawing Attached Areas

In previous versions, you would define any attached areas first and then establish a point of beginning. As we did with the first area we drew, we will skip the define area process and simply draw more lines that make up additional areas. For this example, we’ll pick up where we left off on our previous sketch. To do this, we will use one of our alignment functions we call Jump. Place your cursor near the point as illustrated in the following screenshot.

![Positioning Cursor Prior to Using Jump]

Press \text{ENTER} and your cursor will jump to the end point as shown to the right. This ensures the cursor is precisely where you need it to be for attachment.

Press \text{ENTER} to put the pen down and establish a point of beginning. The cursor will change to green indicating you’re ready to draw.
Your screen should look similar to the following:

First Line of Attached Area

**Drawing Curves**

Curves are another encounter that can turn a beautiful day into a nightmare. On one hand, they’re not always easy to measure and on the other you need to draw it on your computer! Don’t worry. Apex makes drawing curves a breeze and in this example, we’ll cover everything you need to gather to draw them accurately. Before we begin the curve it’s important to understand all the components that make up the curve with regard to Apex.
Touch Drawing Method (continued)

Degree of Curvature (Arc Angle)
Also known as Degree of Curvature takes into account “how much of the circle” in degrees does this arc measure to. You won’t need to draw circles to discern the curvature. You measure other key elements (Arc Length, Chord Length, Arc Height) to achieve that.

Chord Length
Chord Length is the straight measurement between the endpoints of the curve. The Chord length is essential in determining the Arc Angle when using the Curve Solver as without it you won’t have enough data to build the curve accurately.

Arc Length
This is the most common element of the curve that you’d measure in the field since most of your perimeter measurements are taken from the outside of the property. You’ll find that the majority of the time, the curves you encounter are simply rounded corners (90°) that are fairly easy to measure. However, there may be times when the Arc Length is extremely difficult to obtain and you must rely on other measurements to help you construct the curve properly.

Arc Height
Arc Height is the distance from the center of the Chord to the Apex of the Arc. This measurement is crucial in determining the Arc Angle if you have the Chord Length, but are unable to measure the Arc Length.

Methods for Drawing Curves
To draw curves through the touch panel in Apex Sketch v6 you can choose from the curve tools available.

Pressing the Curve Left button will bow the curve to the left (in relation to drawing direction). Each press (without any modifiers) will increment the degree of curvature by 15°.

Pressing the Curve Right button will bow the curve to the right (in relation to drawing direction). Each press (without any modifiers) will increment the degree of curvature by 15°.

Note: Modifiers are Ctrl and Shift which affect the granularity of each press (i.e. 15°, 5°, 1°). You’ll learn more about these modifiers next.
Curve Modifiers (Shift & Ctrl)
When performing any of the functions to create a curve, toggling the and keys can aid you in the accuracy based on what elements you are able to measure based on Degree of Curvature or Arc Height.

<table>
<thead>
<tr>
<th>Key Press</th>
<th>Function</th>
<th>D (Degree)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Key Press" /></td>
<td>Bow Curve</td>
<td>15°</td>
</tr>
<tr>
<td><img src="image2" alt="Key Press" /></td>
<td>Bow Curve</td>
<td>10°</td>
</tr>
<tr>
<td><img src="image3" alt="Key Press" /></td>
<td>Bow Curve</td>
<td>1°</td>
</tr>
</tbody>
</table>

The curve for our sketch is a rounded corner (90°) whose first point is already established at the end of the 17’ line (A) in the illustration below. We’ve also measured our second point to be 10 feet up from the end point of the 27’ line (B).

![Diagram](image4)

**Note:** Many users find using reference points to be handy by making note of where the curve begins and ends. This helps you place the Chord easily and from there apply essential measurements of Arc Height, Arc Angle or Arc Length.
To draw this curve in Apex, do the following:

1. **10 feet down. Don’t press ENTER**
2. **Align Right (make sure is active). Don’t press ENTER**
3. **Curve Right 6 times. Until Degree of Curvature is 90°**

Your screen should look similar to the following:

![Curve Drawn](image)

**Note:** The curve could have also been positioned after changing the degree or arc height as well. Using what you’ve already learned, you could have bowed the curve with (Curve Right button), placed it near the end point of the 17’ line (B) and pressed to jump to the point, then to position the curve.
Let’s continue with our sketch by completing this area as well as add the final area of our sketch.

10 feet down, Anchor the line (ENTER)

25.5 feet right, Anchor the line (ENTER)

28.5 feet down, Anchor the line (ENTER)

25.5 feet left (make sure is active), Anchor the line (ENTER)

Press ENTER to pick the pen up.

Your screen should look similar to the following:

Now that you’ve completed drawing your sketch with Keyboard & Mouse, all you need to do now is define the areas you’ve just drawn. You can skip ahead to Chapter 4 – Area Definition to learn more about this topic.
DISTO Drawing

Remember when you wished that you could just “think” your sketches right onto your clipboard? Well this isn’t that either, but we come pretty close. We’ll show you how to use your DISTO to transmit your measurements to your Windows Tablet device. Whether you prefer to edit lines as you go or actually control distance and direction from your DISTO laser meter, you’ll learn why so many people have shelved their tape measures.

Pairing your DISTO

Before you can begin transmitting information to Apex Sketch v6, it is essential that you pair your DISTO with your mobile device. The following will guide you through an example of pairing a DISTO laser meter with Windows 8/8.1, which should be very similar regardless of your DISTO model or operating system.

Turn on your DISTO. Press and hold the Bluetooth button until the icon appears in the DISTO display.

*Note:* Depending on the DISTO settings, you may hear an audible “beep” when Bluetooth is turned on and/or connected with your Tablet PC.

Once Bluetooth is on/enabled, you’re ready to pair the device with your tablet PC. Within Windows 8/8.1, navigate to Settings which is located at the bottom of your charms menu.

The Settings menu will appear. Select Change PC Settings located at the bottom of the panel as you see here.
From the **PC and Devices** menu, select the **Bluetooth** menu option which will allow you to **Manage Bluetooth Devices**.

**Note:** If Bluetooth is off, be sure to turn it on with the switch provided in this panel.

Your Tablet PC will begin to poll for nearby Bluetooth and indicate those that are “Ready to pair”. Your DISTO device should appear on this list.

Select your DISTO device and then press the **Pair** button.

You may be prompted to input the passcode for the DISTO device. The passcode for DISTO is typically “0000” (four zeros).

Once you’ve input the passcode and it is accepted, you will see a progress bar as it attempts to pair your Tablet PC with the DISTO. Once the process is complete, the status for the DISTO will change to “Paired” if successful.

**Note:** Although the steps (above) are similar for pairing most any Bluetooth device, the steps for activating Bluetooth on your DISTO and/or Windows may vary slightly. Please reference your DISTO user manual for specific instructions regarding device pairing.
Your DISTO Model

Legacy Bluetooth models of the Leica DISTO® (i.e. DISTO Plus, A6, D8) connect and operate with Apex Sketch v6 with little or no setup. If you’ve purchased a newer model (i.e. D510, E7500i, D810), there may be some additional configuration items you must perform in Apex Sketch and/or the DISTO device. The following chart is a general overview of the devices that may require additional configuration/setup.

<table>
<thead>
<tr>
<th>Device Setup?</th>
<th>Plus</th>
<th>A6</th>
<th>D330i</th>
<th>D8</th>
<th>D510</th>
<th>E7500i</th>
<th>D810 Touch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apex Setup?</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>Edit in Place</td>
<td>None</td>
</tr>
</tbody>
</table>

DISTO D810 Device Setup

Currently, the only supported DISTO that requires additional setup is the D810 Touch. You can reference the following to configure the D810 to function properly in Apex Sketch v6.

1. Turn on your D810 and press the FUNC button.
2. Tap the Bluetooth symbol as shown above.
3. Select the top “spread sheet” setting.
4. Tap the Bluetooth setting as shown above.
5. Be sure none and 0.0 are selected.
6. Press the FUNC and you’re set to use the D810 with Apex Sketch v6!
Configuring Apex Sketch v6 for DISTO use

Typically, the only setting you need to choose within Apex Sketch is the mode you wish to use with your DISTO. However, with certain DISTO models such as the D510 and E7500i, the only usable setting is “Edit in Place” as these models do not the directional drawing of Apex Sketch’s “Interactive” mode. You can change these configuration settings by selection Options from the Tools menu.

![Hardware (DISTO) Settings](image)

**Edit in Place**

Edit in place allows you to draw single or multiple lines and transmit your measurements to the active (selected) line.

**Interactive**

Interactive mode allows Apex Sketch to receive both measurement and direction allowing you to draw your sketches almost exclusively from your DISTO device. Although you may choose this selection for any DISTO, it will not function properly with the D510 or E7500i because they do not pass directional information. The D810 is limited to Up, Down, Left, Right bearings as it does not support/pass diagonal direction as previous models do (i.e D8, A6, Plus)

*Note:* You’ll learn more about Edit in Place and Interactive drawing later in this chapter.

Connecting to your DISTO from Apex Sketch v6

It is not necessary for you to establish connection with your DISTO outside of Apex Sketch; rather, that you only pair the device as described at the beginning of this section. Once you have paired your DISTO and made any necessary configuration changes, you’re ready to connect and transmit your measurements to Apex Sketch.

Make sure the DISTO’s Bluetooth is turned on.

Access the Tools menu and select Connect. If the sound settings for your DISTO are turned on, you may hear and audible “beep” indicating you have established connection.
Chapter 4

Area Definition
Area Definition

The Define Area panel supports both Drag & Drop Area Definition and Additive Area Definition which both have their advantages. The following descriptions will give you a better understanding of each method which you can learn more about in the tutorials provided in this reference guide.

What happens if the lines in Areas don’t connect?
Apex Sketch is designed to detect shapes. In order to do this properly, lines must be connected (or overlapping) for Areas to be detected, created and calculated. In a case where lines are not connected, Apex Sketch will not detect the shape, thus cannot define or calculate the Area. You can learn more about shapes that pass or fail in Chapter 4 – Area Definition.

The shape above does not have connected lines. The highlighted intersection between the 10’ and 20’ line illustrate a “gap” which would prevent Apex Sketch from detecting this shape area as a valid Area.

This shape is properly connected at all points and would be recognized and detected when defining Areas.

This is an exception to the rule that all lines must be connected. Because the 15’ and 25’ line overlap, a new point (vertex) will be created where they intersect and the dimensions will change accordingly.

Note: In the case of overlapped lines, the lines are essentially “cut” at the intersection during the Define Area process. The “leftover” portions of each segment would still remain and may need to be removed (deleted) from the sketch if you no longer need them.
Drag & Drop Area Definition

Just as the name implies, to define a closed shape – all you need to do is drag the area definition into a closed shape and the area definition will be instantly applied and calculated. The following example is a step-by-step approach to defining areas in Apex Sketch v6 using Drag & Drop.

We’ll assume the areas (to the right) have already been drawn and you wish to apply area definitions from the Define Area Panel.

Click (or tap) the Define Area Tool or the Define Area Tab as shown to the right.

**Note:** You can also access the Define Area Panel with the shortcut key: F4
The Define Area panel will open. The sketch will adjust to accommodate the panel.

Note: When clicking the Define Area Tab, the sketch will not adjust until you lock the tab open by clicking or tapping the button. When used in an “unlocked” fashion the panel will auto-close when the definition is dragged out of the panel.

Locate the Area Definition you wish use in your library and drag it into the area you wish to apply it to.

Note: The Area Preview in the lower right indicates how the area will appear when the definition is applied.

Keep in mind that your Area Library may not match or look the same as the illustration above. If the category is collapsed (sub-areas not displayed), simply click the “+” to the left of the Main Area Category and the sub-areas will be displayed. Conversely, if too many Area Definitions are in view you may click the “-” to collapse the category.

Note: Main Category Types cannot be used to define areas. When attempting to drag a main area type onto the drawing canvas, the label will not appear thus the area will not be defined and/or calculated.
Drag & Drop Area Definition (continued)

Release the mouse button or pull your pen away from the screen and the Area Definition will be applied.

In this example, the auto-post options (located in the lower portion of the define area panel) have the Name, Calculations and Dimensions checked which is reflected in the newly defined area.

Continuing to define the other two areas in the sketch using the same Drag & Drop method will result in a sketch that looks similar to this illustration.

Note: If you drag a definition into an area that has already been defined, it will redefine the area as the selected area definition. If your intention is to create a new area, you must use Clone Area and/or Copy & Paste and then define the area by dragging the desired definition into it.
Multi-Level Area Definition using Drag & Drop

When using the Drag & Drop method, defining multi-level areas requires that you define areas in a “level by level” fashion. In our example, we drew and defined all of the “Level 1” areas. To add (say) a second floor area, it is important that the first floor (or any other areas it may overlap) be defined prior to drawing the second floor lines. The following continues with the addition of the Second Floor area to our example.

For the purpose of this example, the First Floor label along with its Calculation have been moved and additional lines have been drawn (as indicated) to complete what will be defined as the second floor.

**Note:** To move any selected object in Apex Sketch v6, you must be in Select Mode. This function is located at the top of the left toolbar (cursor icon).

As you will learn in the tutorial section, Apex Sketch v6 does not require you to draw or trace lines back to the POB (Point of Beginning) to complete areas. Only those lines necessary to complete the shape should be drawn. In this example, only two lines were required.

As we did for all the previous areas, simply Drag & Drop the Second Floor Area Definition into the close shape.
Multi-Level Area Definition using Drag & Drop (continued)

The Second Floor has been defined and the line style properties for this definition have been applied.

**Note:** Had the First Floor not been defined prior to drawing the Second Floor lines as illustrated in the previous step, the First Floor would have been much smaller, thus produce undesired results.

To give you a visual illustration of the areas in an "unstacked" fashion, the Second Floor was moved to the right allowing you to see each area in its entirety.
Additive Area Definition

Apex Sketch v6 introduces a new approach to Area Definition that offers much more flexibility than ever before. Additive Area Definition is an alternative to the Drag & Drop method that allows you to build areas by piecing (or adding) them together. As you continue to use this form of Area Definition, you may find this to be the preferred method as you do not have to conform to the same rules when using Drag & Drop.

Let’s start with the same sketch we used for Drag & Drop Area Definition, but this time we will use all of the lines that make up the entire property, including the Second Floor.

**Note:** With Additive Area Definition you do not need to worry with drawing level-by-level. Simply draw all of the lines you need to create areas from.

Click (or tap) the Define Area Tool or the Define Area Tab as shown to the right.

**Note:** You can also access the Define Area Panel with the shortcut key: \[F4\]
Click or tap within the area as illustrated to the right. If you selected the wrong area, you can simply click in an open space outside of the areas to “unselect” any detected areas.

Apex Sketch will detect the area’s boundaries using existing lines. You may notice that this is not the entire First Floor which should include the area just below. We’ll “add” the area in the following steps.

You may discover that defining areas in this fashion is actually quicker than the define area process in previous versions. Although it takes some getting used to, Additive Area Definition determines line lengths and creates new walls based on the boundaries of the shapes it detects, ultimately saving you time you would have spent drawing each wall/line manually.
Next, click or tap the lower area as shown here.

**Note:** You don’t need to press `CTRL` to select multiple areas as you might traditionally do for the selection of other object in Apex Sketch. Simply click all the areas you wish to include in the area you would like to define.

The selected areas will be combined highlighting the boundaries that make up what will become the First Floor.

Calculations are also displayed giving you visual feedback before completing the process.

This process (hence the name) allows you to build areas from existing lines and other areas without the worry of overlapping areas or level-by-level consideration. Additive Area Definition is an intuitive approach to leveraging walls/lines you’ve already drawn and in some cases – determining dimensions that would have been difficult to measure or discern otherwise.
Click or tap the Area Definition (in this case, GLA1 – First Floor). The definition will highlight as illustrated.

Click or tap the Apply button to create the First Floor area.

If you’re an existing user, the concept of draw first, define second may feel a little backwards at first. Through repeated use, you’ll find defining areas in this fashion gets around the issue of having to know what you’re drawing before you draw it. This is especially true while drawing in the field where many times you simply don’t know what you’re drawing until much later in the process.
The First Floor area definition will be applied and labeled accordingly.

**Note:** Don’t worry about the label placement. They can be moved at any time using the Select Tool.

Repeat these previous steps to define the remaining areas (including the second floor). Once you are finished, the sketch should look similar to the illustration to the right.

**Note:** Redundant dimensions have been removed to reduce the clutter in this example. You can do this using the Select Tool and Delete function.

You can learn more about the actual drawing methods for creating the lines that make up the areas in the Drawing Methods Chapter of this reference guide. If you require further assistance with the drawing process for Apex Sketch v6, give us a call (800.858.9958).
Modifying/Customizing Area Definitions

When you click (or tap) the Edit button within the Area Definitions panel you may be prompted for a password (Pro Edition) which by default is the word “password” (all lower-case). This allows companies to secure and maintain uniform standard across the company by preventing inadvertent (or intentional) modification of the Area Definitions library. Where integration is involved, this is also necessary at times to preserve Area Definitions to ensure proper integration and data exchange.

To access the Define Area Library for modification purposes, you must first enter the password (“password” by default). Once entered correctly, the Area Definitions Library will open immediately.

Password Entry Dialog

Area Code & Name: Displays the Code and Area name of the selected Area Definition.

Area Definitions: This area displays the existing Area Definitions contained in your library. Changes you make here will also be displayed in the Area Definitions panel.

Add & Delete: Add will create a new Area Definition below the selected definition in the list. (see note below)

Up & Down: This will move the selected Area Definition up or down the list. This also allows you to move Sub Areas from one category to another.

Apply & Cancel: Apply will save the changes you’ve made and return you to the main screen of the application. Cancel will abort any changes and close the dialog.

Note: When Adding an Area Definition, the new Area Definition will make a copy of the selected Area Definition and place it just below as a Sub Area. Thus, to add a new definition to a particular category, you will need to select the Main Category Header. Otherwise, you will also need to use the Up and/or Down buttons to move the new Area Definition to the appropriate category.
Modifying/Customizing Area Definitions (Area Definitions Panel Continued)

Area Information: This is where you can change the Area Code, Name and Description along with the factor. (see “Applying Factors” below)

Area Calculation: This allows you to configure the default calculation properties for the Area Definition. (see “Area Calculations” below)

Line/Wall Properties: You can choose from several Line Styles, Colors and Thicknesses that will be applied once the area is defined. You can also specify a wall height in this group.

Fill Properties: If you wish to apply a fill pattern and color to your defined areas, select those options from this group.

Smart Area Definition: This function is reserved for Smart Labels which allows users to specify which Smart Label will be triggered when this Area Definition is applied.

Applying Factors
Factors are sometimes necessary when wanting to apply a percentage above or below the base calculation of an Area. For instance, some areas such as unfinished basements are allotted a partial percentage. If this were 50%, you would change this factor to .5 which would be reflected in the calculation once applied.

Area Calculations
Most Area Calculations are positive and default to this setting. However, there may be times where certain area types are always negative and should be defined as such. In these special circumstances, you would set the calculation to negative. For areas that are occasionally negative for calculation purposes (stairwells, atriums, etc.), you can make it negative using the context menu provided in Select Mode.
Appendix

Shortcut Keys & Ink Gestures
Keyboard Shortcuts

- F2: Save Sketch
- F3: Open Sketch
- F4: Area Definition
- F5: Draw Interior Mode
- F6: View Calcs
- F7: Save As
- A: Auto-Close
- C: Center Sketch
- D: (Curve) Degree Mode
- E: Draw Exterior Mode
- H: Horizontal Orientation
- I: Draw Interior Mode
- J: Jump to Point
- L: Rotate Left
- P: Parallel / Pointer
- R: Rotate Right
- S: Symbol Library
- T: Text Library
- V: Vertical Orientation
- +: Grow (TenKey)
- -: Shrink (TenKey)
- DEL: Delete Selected/Line
- INS: Insert Line
- SHIFT: Center & Fit
- CTRL: Copy
- Z: Undo
- Y: Redo
- A: Select All
- X: Cut
- R: Rotate Selected 1°
- Up: Align - Up
- Down: Align - Down
- Left: Align - Left
- Right: Align - Right
- Snap to Line - Up
- Snap to Line - Down
- Snap to Line - Left
- Snap to Line - Right

Additional Short-Cut Key Functionality
A few of the above listed keys have several functions depending on the mode you are in. “H” may be used for Horizontal Dimension and Text Label orientation. Furthermore, while bowing a curve, pressing “H” will also set the curve to Arc Height when increasing for decreasing this measurement.

Modifier Keys
Other than what’s listed above, the [SHIFT] and [CTRL] keys also serve as modifiers when used in conjunction with other functions such as the mouse wheel and/or the [+] or [-] keys. You can learn more about these modifiers in their respective chapters.
Additional Ink Gestures

Any of the following ink gestures may be performed while in Drawing Mode in Apex Sketch v6:

- Change Line Direction
- Undo
- Redo
- Delete Selected
- Align to Next Point

**Note:** The lower case “a” and upper case “A”, must be inked over a dimension (of a line) to take place. All of the other gestures illustrated may be performed anywhere on the screen provided you are in Draw Mode. Additionally, Change Line Direction and Delete Selected require that you have a single line selected. Finally you can also ink in + and - mathematical functions over the dimension to add or subtract specified measurements. (i.e. -4.5 will subtract 4.5 feet from your dimension provided it was greater than 4.5 in length originally).